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RM Billing Primary Training Program 

Day 1 

 

Time Contents 

8.45am COFFEE 

9.00am Welcome 
Housekeeping 
Introductions and Registration 

9.15am Introduction to the RM Billing module 
Logging on and using Help 
Billing Parameters 
Overview of RM Billing 
Creating Billing Codes 
Set Student Billing Category 

10.30am MORNING TEA 

10.50am Creating Billing Items for students 
Billing Students 
Discounts 
Producing Statements 

12.30pm LUNCH 

1.00pm Receipting 
External Customers 

3.00pm Finish 

 

Day 2 

 

Time Contents 

8.45am COFFEE 

9.00am Day One Recap Activity 
Closing the Batches 
RM Billing & RM Finance Interface 
Manual entry of receipts into RM Finance 

10.30am MORNING TEA 

10.50am Receipting Class Collections 
Exporting to RM Finance 
Follow up of unpaid debts 

12.30pm LUNCH 

1.00pm Correcting errors and making adjustments 
Processing Refunds 
Unallocated Credit 
Exporting Re-allocations to RM Finance 
Moving Students to the Former Roll 
Write-offs 
End of Month Procedures 

3.00pm Finish 
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Training Outcomes 
 
At the end of the RM Billing Primary Training Program participants should be able to: 
 

 Create Billing Codes 

 Set Student Billing Categories 

 Create Billing Item batches 

 Bill students in bulk 

 Bill students individually 

 Apply discounts  

 Create receipts batches 

 Apply receipts in bulk 

 Apply individual receipts 

 Produce statements 

 Create records for external customers 

 Export receipts to RM Finance 

 Set up class collections 

 Enter notes for students 

 Correct errors and make adjustments to transactions 

 Process refunds through manual and system cheques and EFT 

 Process reversals 

 Export Re-allocations to RM Finance 

 Follow up unpaid amounts 

 Produce a variety of reports 

 Perform student and customer write-offs 
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1 Introduction to the RM Billing Module 
RM Billing is a module that is available within Integris.  When the RM Billing module is added, a 
new sidebar called RM Billing appears. 
 
This module allows both students and external customers (companies and/or individuals external 
to the school environment) to be billed for any type of cost.  Students can be billed for subject 
related costs, charges and voluntary contributions, other optional costs, voluntary approved 
requests, camps and excursions etc. Customers can be billed for items such as hire of the school 
hall etc. 
 
Student details and those of their related contacts (e.g. Parent/Guardian 1, Parent/Guardian 2 etc.)  
should be accurate within the Administration module before adding the RM Billing module.  Each 
student should have one contact nominated as the person who will be responsible for paying their 
fees.  Correspondence generated from RM Billing - such as Charges and Contributions Sheets and 
Statements - will be addressed to the first contact marked for Fees Billing for each student in the 
Administration module. RM Billing will draw on student and contact data held in the Administration 
module. 
 
The RM Billing module can be used in conjunction with the Timetabling module (optional).  Student 
subject preferences from Timetabling are available in RM Billing.  Costs for each subject can be 
entered in RM Billing and students can be billed according to the subjects they have chosen to 
study.  The bulk billing facility enables students to be billed en masse for any other types of costs.  
 
RM Billing supports several methods of receipting (including bulk receipting) and provides a suite 
of useful reports. 
 
RM Billing is also linked to RM Finance. A set of Billing Codes created in RM Billing provide the link 
to the budget and analysis codes used by the school in RM Finance. Receipts entered in RM 
Billing can be automatically exported to RM Finance against the correct budget and analysis 
codes.  
 
The following diagram illustrates how RM Billing interacts with other Integris modules. 
 

 

 
ADMINISTRATION MANAGER 

 
TIMETABLING 

RM 

BILLING 

 
RM FINANCE 
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Logging on to the System 
 

Activity: Logging On 
 

 Double click on the RM Billing Primary icon on your desktop 
 

 
 

 Type ADMIN into the User Name field 

 Press the <Tab> key 

 Type keys into the Password field 
 

 
 

 Click on Login, or press <Enter> 
 

Note: In schools, each user has their own user name and password, which enables access 
to particular sections of the software as determined by the school administration.  It is 
strongly recommended you change your password regularly. 

 
  



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 13 of 277 

© 2019 Civica Pty Ltd 

 

1.1 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 
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Activity: The File Menu 

Top Toolbar > File 

 View each of the following items in the File menu 
o Password 
o Change User 
o Lock Terminal 
o Report Destination 

 

 

1.2 Accessing Help 

Activity 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

 
 
 

 
 

 Highlight Integris RM Billing Help 

 Click Help 

 View the manual  

 Close the manual and Help 
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2 Implementation of RM Billing at Your School 
As with any new Integris module the RM Billing module must be implemented at your school before 
it can be used. 
 
There is a standard process for the implementation of this new module which will be completed by 
your project officer. In this training course we will mirror the process to be used at your school as 
closely as possible so that you can assist the project officer in the implementation process. 
 

2.1 Step 1 - Preparation of Administration Manager Data 

Before implementing the RM Billing module it is important that the data held in the Administration 
Manager module is as accurate as possible and is set up for use with RM Billing.   
This is because the RM Billing module accesses data held in the Administration module.  In 
particular, student names and the details of their associated contacts (e.g. parents/guardians) are 
used by RM Billing. 
 

2.1.1 Ensure Administration Manager Data is Accurate 

You should ensure that the student names and addresses and the names and addresses of their 
contacts are up to date. If you have been advised of any name or address changes then these 
should be updated before the module is added. 
 
Refer to the document ‘Student Details – SIS Data Entry Procedures’ available from 
http://www.det.wa.edu.au/education/sis/dataentryprocedures.htm 

 

Activity: Updating Parent/Guardian Details 
 
Jennifer Dunstan’s address details and her Parent/Guardian information is incomplete and 
incorrect. Add the following details for Jennifer. 

General > Student Details  

 Type DUN,J in the Search field  

 Press <Enter> to display Jennifer Dunstan’s student details 

 Click on the Edit pencil  

 Enter Jennifer’s address as follows: 
 
48 Hodgson Street 
TUART HILL 
6060 
Tel:  9444 1890 
 

  

http://www.det.wa.edu.au/education/sis/dataentryprocedures.htm
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 Choose Family Group tab 

 Select Parent/Guardian 1 tab 

 Enter the Title: Mrs 

 Enter Surname: Peters 

 Enter First Name: Jackie 

 Change the relationship to Stepmother 

 Make sure that the boxes are ticked for Parental Responsibility/Fees Billing/Student 
Res/FMM 

 Salutation: Mrs Peters and Mr Dunstan (as per DoE data entry guidelines) 

 Select Parent/Guardian 2 tab 

 Check the information for the father Benny Dunstan 

 Remove the Salutation as he is not a Family Mail Marker 

 Click OK 

Note: The fees billing information is shown on the front screen of General > Student 
Details in the lower window. 

 
 

 

2.1.2 Set the Fees Billing Marker 

Each student to be billed must have one contact nominated as their ‘Fees Biller’. This should be 
the person who is responsible for paying any costs associated with the student (i.e. the contact 
who has been marked as the Fees Billing Marker on the Admissions Form). 
 
RM Billing will only use one contact for the fees biller. It is not possible to have multiple fees billing 
contacts in RM Billing. It is therefore recommended that only one contact be ticked on for Fees 
Billing in the Administration module.  

IMPORTANT 

If more than one contact is ticked for Fees Billing in the Administration 
module, RM Billing will use the first contact found with the Fees Billing 

marker ticked.  The software will search the contacts in the order of 
Parent Guardian 1, followed by Parent Guardian 2, followed by any other 
contacts in the order listed. The first contact found with the fees billing 

marker ticked will be the contact that RM Billing will select as being 
responsible for the student’s associated costs. 

It is likely that your school will have already set the fees billing marker from the information listed 
on the Admissions form.   
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However, if you do not have the Fees Billing Marker already set for your students you can use 
speed edit to help with the editing. 
 

Activity: Speed Editing the Fees Billing Marker 
 
We will set the fees billing marker to PG1 for all students on the current roll. 

Admin > Speed Edit 

 Click on the dropdown box called ‘Area’ and select   

 Click on the student search binoculars   

 Click Find 

 Click Select 

 Choose Yes 
 

 Click   to highlight all students 
 

 
 

 Place a tick in the New Value box at the bottom of the window  

 Click the blue tick to make the modifications   

 The letter M will appear in the ‘Status’ column to indicate the records have been ‘Modified’ 

 Click  
 

 

 

 
 

 Click Yes 

 Click Close 
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2.1.3 Students on the Admissions Roll 

Students on the admissions roll can be billed in the same manner as students on the current roll. A 
contact must be nominated as the fees biller. 
 

Activity: Billing students on the Admissions Roll 
 
Set the fees billing marker to Parent Guardian 1 for the following students on the Admissions 
roll. 

 Billy Kelly 

 Lynda Miller 

Admin > Speed Edit 

 Click on the dropdown box called ‘Area’ and select   

 Click on the student search binoculars   

 Choose the roll status of Admissions   

 Click on Find 

 Highlight the students Billy Kelly and Lynda Miller (use the <Ctrl> key) 

 Click on Select 

 Choose Yes 

 Highlight both students  
 

 
 Place a tick in the New Value box at the bottom of the window 

 Click on the blue tick to make the modifications   

 The letter M will appear in the ‘Status’ column 

 Click on Save to save the modifications 

 Click on Yes 

 Click on Close 
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IMPORTANT 

If the contact name changes for the Fees Billing marker for a student 
this can just be edited in the Administration module. RM Billing will be 

automatically updated with the details of the new fees biller.                               

 

2.1.4 Students on the External Roll 

If your school uses an external roll then these students can be billed also. Again a contact must be 
nominated as the fees biller. 
 

2.1.5 Students on the Former Roll 

In most cases it will probably not be necessary to bill students on the former roll. However, it is 
possible to do so by marking a fees biller for them (as for students on any roll). If students on the 
current roll have been billed in RM Billing and they then move to the former roll, their billing records 
and details will be retained in RM Billing and can be accessed and dealt with as necessary. 
 

2.1.6 Setting the Fees Billing marker for PG2 or Other Contacts 

If you have any students where the Fees Billing marker needs to be set for Parent/Guardian 2 or 
for another contact you need to do the following: 
 

 Ensure that the fees billing marker for all previous contacts is not ticked 

 Tick the fees billing marker for the correct contact 
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Activity: Assigning PG2 Fees Biller 
 
Mr Ken Amber is responsible for paying the student fees for Kyle Amber.  Mr Amber is PG2. 

General > Student Details 

 Type AMB,K in the Search field  

 Press <Enter> to display Kyle Amber’s student details 

 Click on Edit   

 Select the Family Group tab  

 Select the Parent/Guardian 1 tab 

 Remove the tick from the Fees Billing checkbox for Ms Linum 
 

 
 

 Select the Parent/Guardian 2 tab 

 Place a tick in the Fees Billing checkbox for Mr Amber 

 Also place a tick in the Family Mail Marker box for Mr Amber 

 Enter the Salutation Mr Amber 
 

 
 

 Click on OK  
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2.2 Preparing RM Finance (Discussion Only) 

 Analysis Codes N3100I and N3100E Other Suspense Accounts must be created in RM 
Finance as these are used for recording Unallocated Credit. 

 

RM Finance > Records > Income/Expenditure Analysis 

 
 

 
 

 Budget Code N3199 Billing Suspense Account must be created in RM Finance.  This account 
is used to hold Unallocated Credit recorded in RM Billing. 

 

RM Finance > Records > Budget Accounts 
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Creating a Billing Supplier Code 

It will be necessary to create a general Billing Supplier Code within RM Finance.  This will be used 
for any refunds entered in RM Billing which are exported to RM Finance.  The exact detail of the 
refund will be available in RM Billing. 
 

RM Finance > Records > Income Sources/Suppliers > New Record > General Tab 
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 EFT/BPAY Tab  
 

 
 

 Click OK    to save when completed 
 

Important  

 Ensure the short name is BILL99.  This must be exact – no spaces or 
additional characters 

 

2.3 Adding the RM Billing Module 

The implementation of the RM Billing Module will be undertaken by your Finance Consultant 
(schools) and must not be added by any school personnel.  Your Finance Consultant will manage 
all steps in the preparation for and installing RM Billing, including the recording of any opening 
balances. 

Important 

Your Finance Consultant will manage all steps in the preparation and 
installation of the RM Billing Module. 
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Getting Started 
Once the RM Billing module has been implemented, your Project Officer will assist with the setting 
up of the RM Billing Parameters and Log in procedures. 
 

2.3.1 Setting the General Parameters 

The General tab in the Billing Parameters window must be set in accordance with the following 
instructions: 
 

General Tab  

Monetary Value Warning 
Limit   

Already set to $1000. Leave this as it is. 
(When processing an entered amount exceeding the value 
defined in this box a warning message will be displayed asking 
for confirmation that the entered amount is correct.) 

Date Warning Limit Already set to 30 days. Leave this as it is. 
(When processing, if the date that is entered against a 
transaction is older than the number of days specified in the 
Date Warning Limit box a message will be displayed asking for 
confirmation that the date entered is correct.) 

School’s Biller Code 1 If you have elected to display the BPAY logo on any of the 
relevant documents, enter your school’s BPAY Biller Code into 
this field. 

School’s Biller Code 2 This field should be left blank. It is a provision for possible future 
functionality. 

Last Year End Schools will be advised of the Year End by the Finance 
Consultant (schools) 

Accounting System Already set to RM Finance 

ABN Enter your school’s ABN into this field. e.g.11 222 333 444  

Options Automatically show student balances.  This box is ticked by 
default and displays current student balances when the student 
window opens.  If the option is ‘unticked’, the user has the option 
of showing the balances when the ‘Show Balance’ tab is 
selected in the Student window 

RM Finance Datafile The location and name is set by default to k:\RMDB\finance.df1.  
At school you need to navigate to your datafile. 
For the training course only this is set to 
C:\keys\RMDB\Finance_Demo.df1.   

Enable Export To RM 
Finance 

Do not tick this box at this point of the training course. 
This option allows schools to export their Billing Receipts 
automatically into RM Finance. If not ticked, all income 
transactions need to be entered manually into RM Finance  
Note:  Once this option is ticked and saved it can never be 
‘unticked’.  It is recommended that Primary schools begin 
exporting to RM Finance straight away. Secondary Schools are 
advised not to tick the export function without discussion with 
their Senior Finance Consultant. 

RM Billing Archive File 
Path 

At school this will be set to K:\keys\RMDB\OLDDATA\Billing 
Archive. This folder will hold reports created from a Utility to 
Purge Former Roll Students. The Utility purges all transactions 
from Former Roll students with a zero balance and a leave date 
of at least one year prior to the last year end date, along with 
those transactions from students who have been deleted from 
Admin.  
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Note: If your school initially decides against exporting to RM Finance, please discuss this 
with your Senior Finance Consultant (schools). 
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2.3.2 Charges and Contributions Parameters 

As primary schools do not use RM Billing to produce a Charges and Contributions Sheet, it will not 
be necessary to make any changes to the settings on the Charges and Contributions tab. The 
following table is included as a reference only. 
 

Charges and Contributions Tab  

Show School Address   Tick this box if you would like the school 
name and address to be printed at the top 
of the Charges and Contributions Sheet. If 
unticked the school name and address will 
not appear so that school letterhead can 
be used. 

Show School Logo on right hand side Tick this box if you would like the school 
logo to appear on the right hand side of 
the header. 

Show Department Logo on left hand side 
(See note below) 

Tick this box if you require the 
department’s logo to appear on the left 
hand side of the header. 

Narrow Logo/Wide Logo If you have elected to show the 
department’s logo you must then choose 
the correct radio button to indicate 
whether the narrow or wide version of the 
logo is being used. 

Department Logo Path If you have elected to show the 
department’s logo then click on the spy 
glass to the right of this field and navigate 
to the location where the logo is stored. 

Show BPAY Logo Tick this box if you would like the BPAY 
logo to be displayed on the Charges and 
Contributions Sheet. 

Show Remittance Advice Tick this box if you would like a remittance 
advice slip to be printed at the end of each 
Charges and Contributions report.  

 

 For Primary training we do not have any settings on the Charges and Contributions tab. 
 

Note: Schools are not to use the Department Logo on any items unless they have an 
international element to their operations 
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2.3.3 Statement Parameters 

 

Statements Tab  

Default Statement Message Enter a message which the school would like 
to appear on the bottom of the student 
statements,  E.g.  ‘Please contact the school 
office on 9229 7777 if you have any queries 
regarding this account’. 
Note that the message can be edited/altered at 
the time of printing if required. 
 

Show School Address Tick this box for training.   
 
If this box is ticked, the school’s name, 
address, phone number and ABN will be 
included in the top left hand corner of the 
statement. 
If this option is not ticked, then this space is left 
blank for the school letterhead. 
 

Show School Logo on the right hand side This will allow the school logo to be displayed 
on statements in the top right hand side of the 
report. 
 

Show BPAY Logo Tick this box if you would like the BPAY logo to 
be displayed on the Statement. 
 
BPAY will not apply to Primary Schools. 
 

Show Remittance Advice Tick this box if you would like a remittance 
advice slip to be printed at the end of each 
Statement. 
 

Show CC Number Tick this box if you would like the student’s 
Curriculum Council number to be displayed on 
the Statement. This setting is applicable to the 
Student Statement only (not the Customer 
Statement). 
 
Not applicable in Primary Schools. 
 

Default Reminder Notice Default Reminder Notices can be sent out 
reminding Fees Billers of Unpaid Billing Items. 
Enter a message which the school would like 
to appear on the bottom of the reminder notice,  
E.g.  ‘Please contact the school office on 9229 
7777 if you have any queries regarding this 
notice’. 
Note that the message can be edited/altered at 
the time of printing if required. 
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Activity:  Log into RM Billing 
 
When first opening the RM Billing sidebar and selecting a function from the sidebar, the user will 
be presented with the RM Finance log in window. RM Billing performs certain validation within 
the linked RM Finance datafile based on the RM Finance user login.  In order to achieve this 
validation, the user’s RM Finance login details must be entered and validated before the user 
can proceed.  This does not indicate the user has logged into RM Finance as this is entered in a 
separate log in window when opening Finance from the Finance icon. 
 
RM Billing > Parameters 
 

 Double click on Parameters 

 Highlight Manager Corporate Services 

 Enter the Password Keys 
 

 
 

 Click Login or <Enter> 
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2.3.4 Enter the Statement Parameters 

Activity: Create Statement 
 
RM Billing > Billing Parameters > Statement Tab 
 

 Click on   

 Enter the Statement Parameters as shown below 

 Include a message for both Statements and the Reminder Notice 
 

 
 
You may wish to include Bank Account Details if you wish parents to pay by Direct Deposit. 
 

Note:  The statement parameter settings will apply to both student and customer 
statements. 
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2.3.5 Invoice Parameters 

 

Invoice Tab  

Show BPAY Logo If ticked, this will display the BPAY Logo and 
payment details (Biller Code and Reference) 
on the statement. 
 
BPAY will not apply to Primary Schools. 
 

Show Remittance Advice When ticked, a remittance advice will be 
printed on the bottom of the invoice displaying 
the school name, address, school phone 
number, ABN number and school logo. 
 
Note:  There is no option to turn on/off school 
logo.  If set up in General > Control > 
Preferences > Reports, it will appear on 
invoices by default. 

Default Invoice Message Enter a message which the school would like 
to appear on the bottom of the customer 
Invoices.  E.g.  ‘Please contact the school 
office on 9229 7777 if you have any queries 
regarding this account’. 
 
You may wish to include Bank Account Details 
where you wish customers to pay by Direct 
Deposit. 
 
Note that the message can be edited/altered at 
the time of printing if required. 
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2.3.6 Enter Invoice Parameters 

 

Activity: Enter Invoice Message 
 

RM Billing > Billing Parameters > Invoices Tab 

 

 Tick ‘Show Remittance Advice’ 

 Enter a Default Invoice Message 
 

 
 

Note:  The Invoice parameter settings will apply to both student and customer invoices 

 Click OK to save the Parameter settings   and close 
 

 Close the Billing Parameters window 
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3 Brief Overview of RM Billing 

3.1 Students 

The Students section is the ‘basis’ of the RM Billing module. When the window opens, all the 
students on the current roll are displayed along with their current year group and current form. 
 

 
 

3.1.1 Student Icons 

The following icons are available on the Student List screen. 
 

 
Standard Student Find Tool 

 
Load Current Students – Displays all students on the current roll 

 
Open Details – Opens the drill down facility for the selected student 

 
Print – Prints all students displayed in the list view 

 
Print Selected – Prints all selected (highlighted) students in the list view 

 
Hide Selected – Hides all selected students 

 
Hide Unselected – Hides all unselected students 

 
Show/Hide Deleted Students – Displays students who have been deleted from 
the Administration module but still have a record in RM Billing 
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3.1.2  Opening the Students Window 

The very first time the Students window is opened in RM Billing a record for each student on the 
current roll will be created in RM Billing. Therefore this process may take a few minutes when run 
for the first time.  
 

3.1.3 Using the Student Window Icons 

Activity: 

RM Billing > Students 

 

 Click Find Student  

 Select Year Group 6 to display only the Year 6 students 

 Find > Select > Yes 

 Click Load Current Students  to display all students who are on the current roll 

 Highlight any student and select Open Details  

 Click Return to View  

 Click Print List  

 Close the Student Summary Report 

 Hold <Ctrl> and select 5 students from the list 

 Click Print Selected  

 Close the Student Summary – Selected Items Report 

 Click Hide Selected  to hide those selected students 

 Hold <Ctrl> and select 5 students from the list 

 Click Hide Unselected  to only view those selected students 

 Click Load Current Students  to display all students who are on the current roll 

 Click on the Notes Header twice to bring all students with Notes attached to their record to 
the top of the window 

 Highlight the students with notes 
 

 
 

 Click For Selected and Print Notes 

 Leave the date range blank to print all notes 

 View and close the Notes Report 
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3.1.4 Quick Search on Student Surname 

A quick search on student surname is available in this window. For example, if you click on the first 
student in the list and then type the letter ‘B’ the cursor will move to the first student whose 
surname begins with ‘B’. If you type the entire surname (e.g. BORN), the first student in the list with 
that surname will be highlighted. 

3.1.5 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a student name. 
Note that all transactions will be attached to the student’s record. The name of the fees biller is 
also attached to this record. 

3.1.6 Red Fields 

The red fields at the top of the screen are scroll fields and search fields.   

 Left mouse click to view the next student. 

 Shift and left mouse click to view the previous student.     

 Right mouse click to enter the name of a new student to view.   

 It is recommended that users work with smaller groups of students and this method is used 
to navigate between students. 

 

 

Note: It is advisable (and quicker) to search for students from within the drill down section 
rather than always returning to the front screen. Either the red fields or the binoculars can 
be used. 

3.1.7 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen.   
Selecting Return to View will recalculate student balances.    
 

Activity: Searching for Students 

RM Billing > Students 

 Type the Surname Avery 

 Double click Charmaine Avery 

 View the tabs available in the student window 

 Click on the red Surname field  to scroll through the student names 

 Right click in the Surname field and type BAKER then press <Enter>.  The first student with 
that surname is displayed 

 Close the Student details window 
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3.2 Customers 

This section is used to bill customers who are external to the school (i.e. not 
parents/guardians/students). For example the local theatre group who wish to hire the school hall 
for their rehearsals. 
 
Customer records can be created at any time by the user.  
 
The functionality available in the Customers section is very similar to the functionality available in 
the Students section. 
 

 
 

3.2.1 Customer Icons 

The following icons are available in the Customers section. 
 

 
Load All – Displays all customers in the list view 

 
Open Details – Opens the drill down facility for the selected customer 

 
Print – Prints all customers displayed in the list view 

 
Print Selected – Prints all selected (highlighted) customers in the list view 

 
Hide Selected – Hides all selected customers 

 
Hide Unselected – Hides all unselected customers 

 
Add Customer – Allows a customer record to be added 

 
Edit Customer – Allows a customer record to be edited (restricted editing only if 
there are transactions against the customer) 

 
Delete Customer - Allows a customer record to be deleted (only if there are no 
transactions against the customer) 
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3.2.2 Quick Search on Customer Name 

A quick search on Customer Name is available on this window. For example, if you click on the first 
Customer and then type the letter ‘B’ the cursor will move to the first Customer whose name begins 
with ‘B’. If you type the entire Customer Name then that Customer Name will be highlighted.   
 

3.2.3 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a Customer Name. 
 

3.2.4 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen.   
Selecting return to view will recalculate student balances.    
 
 

3.3 Billing Items 

This section is used to create Billing Item batches. These batches will hold the billing item 
transactions once the students have been billed. The standard icons which have already been 
discussed are available on this window. 
 

 
 



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 37 of 277 

© 2019 Civica Pty Ltd 

 

3.4 Receipts 

The Receipts section is used to create Receipts batches. These batches will hold the receipts 
entered into RM Billing. The standard icons which have already been discussed are also available 
on this window. 
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3.5 Reports 

A variety of standard reports are available from this section as illustrated below. These will be 
covered as we progress through the training course. 
 

 
 

3.6 Parameters 

Parameters can be set to customise the RM Billing module for use in your school. More detail will 
be provided on the relevant parameters during the course of this training. 
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3.7 Utilities 

The Utilities section provides a set of standard routines/processes that need to be run at certain 
times within the RM Billing module. Again, the relevant processes will be covered as we progress 
through the training. 
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4 Using RM Billing – Other Required Settings  
Billing Codes provide a link between RM Finance and RM Billing. 
 
In RM Billing the Billing Code represents a general type of item for which a student can be billed.  
For example, we could create a billing code for Voluntary Contributions – Years K to 6. The billing 
code is linked to a specific analysis code and budget code within RM Finance which, for this 
example, would relate to the Voluntary Contributions for years K to 6.  
 
Billing Codes must also be linked to a billing category. The billing categories are the standard 
education categories – Voluntary Contributions, Charges, Other Optional Costs, Voluntary 
Approved Requests, Residential Boarding Fees, Adult Student Fees and Temporary Visa 
Overseas Students. An additional category of ‘Not Applicable’ is also available. 

4.1 System-Defined Billing Codes 

There are two system created billing codes NA and SUS. 
 
NA- This Billing Code can only be used if directed 
 
SUS-This Billing Code relates to the Billing Suspense Account N3199 in RM Finance.  It is used to 
receipt or refund any amounts held as Unallocated Credit.  That is amounts that have not been 
allocated against any Billing Items. 
 

4.2 User-defined Billing Codes 

It will be necessary to create some additional billing codes to be used at your school. These Billing 
Codes will represent the items/activities for which your students are commonly billed. 
For example, Voluntary Contributions Yrs K-6, School Camps, Excursions, School Magazine etc. 
Each Billing Code must be attached to the correct billing category (as mentioned earlier) to ensure 
that the types of costs are correctly classified. 
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4.2.1 Naming of Billing Codes 

There is a standard naming convention which should be followed when you are creating the billing 
codes for your school.  
 

Each Billing Code should begin with a standard 3 letter code followed by a two digit number. Refer 
to the table below for details.  

4.2.2 Standard Naming Convention for Billing Codes 

 

Code Begins 
with 

For Category Code Used For (examples) 

VOL Voluntary Contributions Secondary Subject Voluntary 
Contributions 
Primary Voluntary Contributions 

CHG Charges Subject Charges 
School Camps 
School Excursions 
Hire of Facilities 

OOC Other Optional Costs School Magazine 
Yearbook 

VAR Voluntary Approved Requests P&C Contributions 
Chaplain 

NA Not Applicable Only use if directed 

REF Not Applicable Refunds 

TVS Temporary Visa Overseas 
Students 

Temporary Visa Student Fees 

ADU Adult Student Fees Adult Student Fees 

RBF Residential Boarding Fees Residential Boarding Fees 

Note:  Other than use with refunds, NA should only be used in special circumstances if 
advised by your Senior Finance Consultant (schools). 
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4.2.3 Checking RM Finance and creating Budget Codes where necessary 

Each Billing code is linked to a Budget code and corresponding Analysis code in RM Finance.  
This is so that information from RM Billing can be manually or automatically input into RM Finance 
against the correct Budget and Analysis code.  All monies receipted through RM Billing must 
ultimately be input into RM Finance.  We will cover this later in training.   
 
Prior to creating a Billing code the Budget code that we wish to link this billing code to must be 
created in RM Finance.  The user will find that many of the budget codes may already exist in their 
RM Finance datafile.  Those that do not exist can be easily created. 
 
 

Activity: Creating Budget Codes in RM Finance 
 
When viewing a list of charges, contributions, other optional costs and voluntary approved 
requests which are passed on from the Finance committee, we can see that it will be necessary 
to create several new Billing Codes in RM Billing.  Prior to creating these codes, check that the 
corresponding budget codes exist in the RM Finance datafile.  If not, create them.   
 
The following is a list of items that the school expects to have income or expenditure throughout 
the year, but does not have an existing Budget Code in RM Finance.  

Note: These can be added to during the year if and when unexpected income items arise.  

Budget 
Code 

Description Budget 
Heading 

Analysis 
Code 
Income 

Analysis 
Code 
Expenditure 

C1201 Instrumental Music 10REV C1200  

C1202 School Year Book 10REV C1200  

C1203 Graduation Shirt 10 REV C1200  

C1525 Ipad Replacement Fund 10REV C1500  

D4602 Refunds Prim Voluntary Contribution 20EXP  D4600 
 

Note:  Budget and Analysis codes used in RM Billing, must not be deleted from RM Finance. 
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RM Finance 

Open RM Finance   
 

 Highlight Manager Corporate Services 

 Enter Password Keys 
 

  
 

 Click Login or <Enter> 
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RM Finance > Records > Budget Accounts 

 Click  

 Type C1201, press <Enter> 
 

 If the Budget Account does not exist click  

 Type C1201 in the Budget Account field <tab> 

 Enter the description Instrumental Music <tab> 

 Select the Budget Heading 10REV <tab> twice 

 Enter the Income Default Analysis of C1200 

 Click  
 

  
 

 Continue to add the remaining budget codes in the table below 
 

Budget 
Code 

Description Budget 
Heading 

Analysis 
Code 
Income 

Analysis 
Code 
Expenditure 

C1202 School Year Book 10REV C1200  

C1203 Graduation Shirt 10REV C1200  

C1525 Ipad Replacement Fund 10REV C1500  

D4602 Refunds Prim Voluntary 
Contributions 

20EXP  D4600 
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Activity:  View Created Codes 

Records > Reports > Default Analysis Codes 

 

 Click on   and view the budget codes and analysis codes. Check new budget 
codes have the correct details, analysis code and budget heading.  A portion of the report is 
displayed below. 

 

 

 
 

 Close the report and minimise RM Finance 

Note:  Budget Codes and Analysis Codes must be created in RM Finance before they are 
available for use in RM Billing 
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4.2.4 Creating a Billing Code 

To create a Billing Code, follow these general rules: 
 

 Determine which category the Billing Code fits into 

 Use the appropriate first three letters given in the table on page 40 

 Add a two digit number to the end of the code (no spaces) e.g. VOL01 

 Give the code a description 

 Assign an Analysis Code to the billing code 

 Assign a Budget Code to the billing code 

 Assign a Billing Category to the billing code 
 

Activity: Add Billing Codes 

RM Billing > Parameters > Billing Codes 

 Click Add Item  

 Type the Billing Code VOL01, press <tab>  

 Type the description Primary Voluntary Contributions <tab> 

 Type the Analysis Code C1000 (or press <tab> for a look-up list) <tab> 

 Enter the Budget Code C1002 (or press <tab> for a look-up list) <tab> 

 Select the category Voluntary Contributions from the drop down list 

 Click OK to save 

 Using the above instructions create the billing codes listed below: 
 

Code Description Analysis 
Code 

Budget 
Code 

Category 

VOL02 Pre-Prim Voluntary 
Contributions 

C1000 C1003 Voluntary 
Contributions 

VOL03 Kindy Voluntary Contributions C1000 C1004 Voluntary 
Contributions 

CHG01 School Camps C1100 C1102 Charges 

CHG02 Excursions C1100 C1103 Charges 

CHG03 Incursions C1100 C1104 Charges 

CHG04 In Term Swimming C1100 C1105 Charges 

OOC01 Instrumental Music C1200 C1201 Other Optional 
Costs 

OOC02 School Year Book C1200 C1202 Other Optional 
Costs 

OOC03 Graduation Shirt C1200 C1203 Other Optional 
Costs 

VAR01 IPad Replacement Fund C1500 C1525 Voluntary Approved 
Requests 

VAR02 P&C Family Contribution N3000I N3005 Voluntary Approved 
Requests 

HIR01 Hire of Facilities C1700 C1705 Charges 
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4.2.5 Editing a Billing Code 

To edit a Billing Code: 
 

 RM Billing > Parameters > Billing Codes 

 Highlight the appropriate code 

 Click on the edit pencil (yellow pencil) 

 Update the required details 

 Click on OK to save 

Note:  Once a Billing Code has been used in a transaction, only the description can be 
edited. 

4.2.6 Deleting a Billing Code 

To delete a Billing Code: 
 

 RM Billing > Parameters > Billing Codes 

 Highlight the appropriate code 

 Click on the delete button (rubbish bin) 

 Answer ‘yes’ to the message 

Note:  Once a Billing Code has been used in a transaction, it cannot be deleted. 

4.2.7 Printing a list of Billing Codes 

To print a list of Billing Codes: 
 

 RM Billing > Parameters > Billing Codes 

 Click on the Printer   
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4.2.8 Refund Billing Codes 

At times it may be necessary to issue a refund via RM Billing. Refund transactions need to relate to 
a ‘D’ account (expenditure) in RM Finance. Therefore special refund type codes need to be created 
in RM Billing which link to the refund analysis and budget codes in RM Finance. 

Note: ‘D’ accounts will only be available for selection once the refund checkbox has been 
ticked. The refund checkbox must be ticked before you can enter your analysis and budget 
codes! 

Activity: Add Refund Codes 

RM Billing > Parameters > Billing Codes 

 Click Add Item  

 Tick the Refund checkbox  

 Type the Billing Code REF01, press <Tab>  

 Type the description Refunds – Primary Vol Cont, press <Tab> 

 Type the Analysis Code D4600 (or press <tab> for a look-up list), press <Tab> 

 Enter the Budget Code D4602 (or press <tab> for a look-up list), press <Tab> 

 Leave the category Not Applicable  

 Click OK to save 

 Using the above instructions create the billing codes listed below (REMEMBER TO TICK 
THE REFUND CHECKBOX): 

 

Code Description Analysis 
Code 

Budget 
Code 

Category 

REF02 Refunds - Charges  D4600 D4626 Not applicable 

REF03 Refunds - Facilities Hire D4800 D4808 Not applicable 

 
Check your data entry is correct.  This can be done by checking from the data entry screen or 
alternatively by printing a report 
 

 Click  and OK to print to the screen. 

 Check the report and Close 

 Close the Billing Codes window 

 Close the Billing Parameters window 
 

Note: Refunds of unallocated credit are processed against a System created code of SUS. 
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5 Setting the Student Billing Category 
Students within RM Billing need to be classified into their student billing category for the current 
billing year. 
 
The available student Billing Categories are: 

 Kindergarten 

 Pre-Primary 

 Primary 

 Secondary (Vol, Chg) 

 Secondary (Chg) 

 Adult 

 Temporary Visa 

 Full Fee Paying 
 
Billing categories must be assigned to all student records.  This includes Admission roll students 
that may be available within the RM Billing module. 
 

Activity: Set Student Billing Category 

RM Billing > Students 

 Sort the students by clicking on the Year group column (or use the Find tool) 

 Select all of the Year K students 

 Choose For Selected > Set Student Billing Category 
 

 
 

 Select Kindergarten from the drop down list  
 

 
 

 Click OK to save 
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 Select all of the Year P students 

 Choose For Selected > Set Student Billing Category 

 Choose Pre-Primary from the drop down list 
 

 
 

 Click OK to save 
 

 Select all of the Year 1 to Year 6 students 

 Choose For Selected > Set Student Billing Category 

 Choose Primary from the drop down list 
 

 
 

 Click OK to save 

 Close the Students window 
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6 Creating Billing Items for Students 
 
Billing items need to be created: 

 Before statements can be produced 

 Before money can be receipted (unless the money is to be entered as unallocated credit) 
 
Billing items can be created by setting up Billing Item batches.  Billing Item batches can be created 
for any items for which students are to be billed.   
 
For example: 

 Voluntary Contribution amounts for Kindergarten, Pre-Primary and Primary students  

 Other Optional Costs 

 Voluntary Approved Requests 

 School Camps, Excursions and Incursions 

6.1 Creating the Billing Item Batch Header 

Activity: Create a Billing Item 
 
Create a Billing Items batch for the Kindergarten Voluntary Contributions. 

RM Billing > Billing Items 

 Click Add Item   

 Select the billing year from the drop down list (only the current and future years are 
available) 

 Enter the description Kindergarten Voluntary Contributions 

 Click OK to save 
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Note: Batch numbers are automatically created by RM Billing. Batch numbers are created 
sequentially beginning at 00001. Batch numbers are not re-used. 

6.1.1 Adding tied billing items 

We will now add a number of tied billing items to this batch header. These are the billing items for 
which the students will be billed. 
 

Activity: Create Tied Billing Items  

RM Billing > Billing Items 

 Click Add Debit   

 Type 2019 Library in the Comment field <tab> 

 Type 5 in the Amount <tab> 

 Type 0 in the GST field or <tab>to select the relevant code from a list <tab> 

 <tab> in the Bill Code field and select the relevant code for Kindergarten Voluntary 
Contributions (VOL03) 

 Click OK  

 Using the method outlined above continue to enter tied billing items as per the screenshot 
 

 
 

 Click Return to View  
 
The new Billing Item is added  
 

 
 
 

Note: If you have more than one tied billing item, each line should be entered separately 
and saved (by clicking on OK).  Each tied billing item must have a description beginning 
with the Billing Year, a GST code (a look up list operates by pressing <tab>) and a Billing 
Code (a look up list operates by pressing <Tab>). Ensure the correct billing code is selected 
for each item. 
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Activity: Create Pre-Primary Voluntary Contributions Batch 
 
Create a Billing Items batch for the Pre-Primary Voluntary Contributions. 

RM Billing > Billing Items 

 Click Add Item  

 Select the billing year from the drop down list (only the current and future years are 
available) 

 Enter the description Pre-Primary Voluntary Contributions 

 Click OK to save 

 Add tied billing items as per the screenshot below 
 

 
 

 Click Return to View  
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6.2 Creating a Billing Items Batch for Contributions – Alternative 
Method 

In the above examples separate Tied Billing Items were created for the Kindergarten and Pre-
Primary Voluntary Contributions.  An alternative method is to create one line item only for the total 
amount. 
 

Activity: Create Primary Voluntary Contributions Batch 

RM Billing > Billing Items 

 Click Add Item  

 Select the billing year (only the current and future years are available) 

 Enter the description Primary Voluntary Contributions 

 Click OK to save 

 Add the tied billing item as per the screenshot below 
 

 
 

 Click OK 

 Click Return to View  

Note: If this method is used, it is important that parents are advised of the composition of 
the voluntary contribution. 
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6.3 Creating Billing Item Batches for Charges, Other Optional Costs 
and Voluntary Approved Requests 

Schools may wish to display items other than Voluntary Contributions on Statements.  If so, billing 
item batches will need to be created for these items in order for students to be billed. 
 

Activity: Creating a Voluntary Approved Request Batch 
 
It has been decided that the school would like to include a Voluntary Approved Request on all 
student statements for an Ipad replacement fund.  Create a Billing Items Batch for Ipad 
replacement. 

RM Billing > Billing Items 

 Click Add Item  

 Follow the screenshot below to enter the relevant details 
 

 
 

 Click OK 

 Click Return to View  
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Activity: Creating an Other Optional Costs Batch 
 
The Year 6 students will have the option to purchase a graduation shirt.  In the past the school 
has found that most students purchase the shirt.  Create a Billing Items Batch for this. 

RM Billing > Billing Items 

 Click Add Item  

 Follow the screenshot below to enter the relevant details 
 

 
 

 Click OK 

 Click Return to View  
 

 
  



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 57 of 277 

© 2019 Civica Pty Ltd 

 

 

6.3.1 Creating a Billing Item to Bill once per Family 

Activity: Create P&C Contributions Batch 
 
Create a billing items batch for the P&C Contribution which is to be charged once per family. 

RM Billing > Billing Items 

 Click Add Item  

 Follow the screenshot below to enter the relevant details 
 

 
 

 Click OK 

 Click Return to View  
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Activity: Review of Creating Billing Item Batches 
 
The Year 6 students will be attending camp.  The cost of the camp is $250.00 and has been 
broken into the following items: 
 

Item Cost GST Code 

2019 Camp Accommodation and Activities $100.00 0 

2019 Camp Transport $40.00 0 

2019 Camp Food $110.00 1 

 
Create a Billing Items Batch for the Camp.  When adding tied billing items use the Billing Code that 
you created earlier (CHG01). 
 
 

 
The Year 3 students will be attending 2 weeks of In Term swimming lessons.  There is no cost for 
the lessons, however there are pool entry and transport costs of $50, which has been broken into 
the following items. 
 
 

Item Cost GST Code 

2019 Swimming Pool Entry $20.00 0 

2019 Swimming Bus Hire $30.00 0 

 
Create a Billing Items Batch for In Term Swimming.  When adding tied billing items, use the Billing 
code which was created earlier (CHG04). 
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6.4 Billing During the Year 

The method outlined in the previous pages can be used at any time to bill students for 
activities/items throughout the year.  
 

Activity: Create an Incursion Batch 
 
The Year 1 and 2 teachers have organised a Science incursion for their students for later in the 
year.  They have sent home a note indicating the total cost will be $10.00.   

RM Billing > Billing Items 

 Add Item  

 Use the screenshot below to create the batch 
 

 
 

 Click OK 

 Close the Billing Items window 
 

 

Activity: Review of Billing During the Year 
 
The Year 4 students will be attending an excursion at the Perth Zoo.  The excursion fee is $20 
(no GST) CHG02.  Create a Billing Items batch. 
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7 Billing Students 
Students can be billed individually or in bulk.  Both methods will be covered. 

7.1 Bulk Billing Students 

Activity:  Bulk Bill Students 
 
Bulk bill the Kindergarten students for their Voluntary Contributions and the IPad Replacement 
Fund voluntary approved request. 

RM Billing > Students 

 Sort by the Year Group 

 Select Kindergarten Students 

 Choose For Selected > Add to Billing Item Batch 
 

 
 

 Select the Kindergarten Voluntary Contributions batch and the IPad Replacement batch 
 

 
 

 Click OK 

 Double click Thy West 

 Select the Billing Items tab and view the newly created billing items 

 Close the Student Details window 
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IMPORTANT 

When billing Kindergarten, Pre-Primary and Primary school students for 
their voluntary contributions, separate billing item batches must be 
created for each group (K, PP and P).  This is because the Voluntary 

Contribution payments must be posted against different Budget Codes 
in RM Finance. 

 

7.2 Viewing Billing Items via the Batch 

Activity: View Billing Items via Batch 
 
View all Billing Items in the Kindergarten Voluntary Contributions Batch.  Print a list of billing 
items in the batch. 

RM Billing > Billing Items 

 Double click on the Kindergarten Voluntary Contributions Batch 

 Click on the Batch Billing Items tab 

 Click on the Student column header to sort the students into alphabetical order 

 Click Print  

 Close the list 

 Select the items for Cassie Brood 

 Click Print Selected  

 Close the list 

 Close the Billing Items window 
 

Note: The Billing Items list can be sorted by any of the Column headers. Billing Items can 

be filtered according to search criteria by clicking on the Filter icon .   
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Activity: Review of Bulk Billing 
 

 Bill the following students for the billing items listed. 
 

Students Billing Items 
 

Pre-Primary  Pre-Primary Voluntary Contributions 

 IPad Replacement Fund 

Year 1 to 5  Primary Voluntary Contributions 

 IPad Replacement Fund 

Year 6  Primary Voluntary Contributions 

 IPad Replacement Fund  

 Year 6 Graduation shirt 

 Year 6 Camp 

Year 3  In Term Swimming Lessons 

Year 1 & 2  Year 1 and 2 Science Incursion 

Year 4  Year 4 Perth Zoo Excursion 

 
 

 View a list of all of the Primary students who have been billed for the Primary Voluntary 
Contributions. 
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7.3 Billing Once per Family 

 
There may be cases where a family should only be charged once for a particular item, rather than 
all siblings in the family being billed individually. For example, P&C Family Contribution. 
 
A suggested method for achieving this is to bill only the student who is marked as the ‘Family 
Representative’.  
 
For this method to be successful, the Family Representative marker must be set correctly in the 
Administration module. 

7.3.1 Viewing the Family Representative 

Activity: Billing Once Per Family 
 
In the training datafile, the eldest sibling has been marked as the family representative.  View the 
records for the Jones family. 

General > Student Details 

 Quick search for Yazeed Jones  

 Right click in the contacts pane and choose Make Siblings the Browse Set 

 View the Family Representative checkbox for Yazeed  
 
It will be empty as he is the younger sibling 
 

  

 Click on the Previous Student arrow  

 The Family Representative checkbox is ticked as Tim is the older sibling 

 Close the Student window 
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Activity: Billing The Family Representative 
 
Bill only the Family Representatives for the P&C Family Contribution. 

RM Billing > Students 

 Click Student Find   

 Select the Address tab 

 Select the Family Representative radio button 
 

 
 

 Click Find, then Select > Yes (only family reps will now appear in the list) 

 Click on the Year column heading to sort the students by Year 

 Select Students from Kindergarten to Year 6 

 For Selected > Add to Billing Item Batch 

 Select the P&C Family Contribution Batch 

 Click OK 

 Click Load Current Students  

 Double click on Tim Jones 

 Select the Billing Items tab and note he has been billed for the P&C Family Contribution 

 Click Return to View  

 Double click on Yazeed Jones 

 Select the Billing Items tab and note that he has not been billed for the P&C Family 
contribution as he was not marked as the Family Representative 

Note:  Using the Assign Family Reps utility ensures all students have a Family 
Representative flagged. This can be found Admin > Utilities > Assign Family 
Representatives. 
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7.4 Automatically Show Student Balances 

Activity: Show Student Balance 

 

Once billing items have been applied to students, the current balance that is owed by each 
student is displayed in the balance column.  Users have the option of viewing the current 
balance once the billing item has been applied or only showing the balances when the ‘Show 
Balance’ checkbox is un-ticked and then selecting to click the ‘Show Balance’ tab in the 
student window. 
 

RM Billing > Billing Parameters > General Tab 

 Click   
 

 Un–tick   
 

 Click OK 
 

 Close Parameters and the Billing Parameters window 
 

 

RM Billing > Students 

 Sort by Year Group 

 Note that the balances have now been hidden 
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Note:  If a school has a large student population, it may take some time to load the 
Student screen after logging into RM billing. If the ‘Automatically show student balances’ 
is deselected in ‘Parameters > Billing Parameters’, the Student screen will open without 
calculating the balance of each student. Once the student screen has opened, the ‘Show 
Balances’ tab can be selected or the ‘Automatically show student balances’ tickbox can 
be checked to display student balances.  

 

 Click the   to display the hidden balances 
 

Note:  It may be necessary to sort by Year Group again in order to group the balances 
 
For training, we will keep the ‘Automatically Show Student Balances Selected’  RM Billing 
> Parameters > Billing Parameters 
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8 Individual Billing 
Billing items can be added to an individual student if required. 
 

Activity: Bill an Individual Student 
 
Haley De Silva has been given special permission to attend the camp.  Bill Haley for all of the 
camp charges. 

RM Billing > Students 

 Double click on Haley DeSilva 

 Select the Billing Items tab 

 Click   

 Choose the Year 6 Camp batch 

 Click OK 

 View the newly added camp items 
 

 
 
 

Leave the window open 
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9 Editing the Amount of a Billing Items Batch  
Users are able to edit details of the batch before applying it to a student’s record.  This allows 
users to customise billing details to meet individual needs as they process billing items.  These 
changes are only reflected on the individual account for which the details have been edited.  The 
original billing item will remain unchanged.  
 

Activity: Edit The Billing Item 
 
Graeme Delamare has also received special permission to attend the camp.  The camp is 
scheduled to run over four days, but Graeme can only attend for two days.  We will edit the 
amount for the tied billing items before applying it to Graeme’s records.  Graeme’s parents will 
be taking him to and from camp therefore he will not be charged for camp transport. 
 

 Right click in the red Surname cell 

 Type in Delamare 

 Press <Enter> 

 Select the Billing Items tab 

 Click on the Add Billing Item button   
 

 Highlight the Year 6 Camp Billing items batch 
 

 
 

 Click on Edit   

 Highlight the Camp Accommodation and Activities Line 
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 Click  the Edit pencil   

 Change the Amount to $50.00 
 

 
 

 Click on the    to save the changes 

 Follow the steps above to edit the Camp Food charges to $55.00 
 

 
 
Graeme will be providing his own transport to and from the Camp, therefore the Camp  
Transport line can be deleted. 
 

 Highlight the Camp Transport line  

 Click on the Delete Debit     
 

 
 
 

 Click Yes to delete the line 
 

 
 

 Click OK and view the edited billing items. 
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Activity:  Edit The Swimming Batch 
 
Due to special circumstances Steven Farnton, Year 5 will attend the Year 3 In Term Swimming 
Lessons.  His mother will provide him with transport to and from the pool.  Apply the In Term 
Swimming billing item and delete the Transport tied billing item. 

RM Billing > Students 

 Right Click in the red Surname cell 

 Type Farnton and <Enter> 

 Ensure you have Steven 

 Select the Billing Items tab 

 Click Add Billing Item   
 

 Highlight the In Term Swimming Lessons Batch 
 

 
 

 Click   
 

 Highlight the 2019 Swimming Bus Hire line 
 

 
 

 Click on   
 

 
 Click Yes to delete the billing item 

 Click OK 
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10  Discounts 
Discounts can be applied in a number of ways.  An individual discount may be applied to a single 
billing item or to multiple billing items e.g. Voluntary Contributions.  Discounts may also be applied 
to multiple students for a specific billing item. 
 
A discount may be applied in the case of a student arriving at the school part-way through the year. 
In this case the student may be entitled to a discounted cost for their voluntary contributions. 

10.1 Applying a discount to a single billing item 

Activity: Individual Discount 
 
Tenille Gray has arrived at the school half way through the year. She is entitled to a 50% 
discount on her voluntary contributions. (Note: She has already been billed for the Primary 
Voluntary Contributions.)  Discount Tennille’s Voluntary Contributions by 50%. 
 

 Right Click in the red Surname cell 

 Type GRAY and <Enter> 

 Click    to scroll to Tenille Gray 

 Select the Billing Items tab 

 Highlight the Primary Voluntary Contributions Billing Item 

 
 

 Click  

 Enter 50 as the discount percentage 

 Enter a reason for the discount (July 2019 – Commenced Term 3) and Click OK 
 

 
 

 View the Discount column, the Balance column and the Reason column 
 

 
 

IMPORTANT: The month and year must be entered in a consistent 
manner.  This is so the Transaction Summary report can be sorted via 
reason containing the month and year.  This is most useful for end of 

month reporting. 
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10.2 Applying a discount to multiple billing items 

Multiple billing items can be discounted at the one time as long as they are all being discounted by 
the same percentage. 
 

Activity: Individual Discount For Voluntary Contributions 
 
Grant Delphine arrived at the school in Term 2. Discount his voluntary contributions by 25%. 
(Note: He has already been billed for the Pre-Primary Voluntary Contributions.) 

RM Billing > Students 

 In the Surname cell, right mouse click to clear the cell 

 In the Surname cell type Delphine then <Enter> 

 Select the Billing Items tab 

 Highlight all of the Voluntary Contributions 
 

 
 

 Click  
 

 Enter 25 as the Discount Percentage 

 Enter April 2019-Commenced Term 2 as the reason 
 

 
 

 Click OK 

 View the Discount column, the Balance column and the Reason column 
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10.3 Applying Bulk Discounts to a Billing Item 

The Batch Billing Items window allows the user to discount, or to remove a discount from a number 
of billing items for a number of students, at the same time. 
 

Activity: Bulk Discount For a Billing Item 
 
The following students have been subsidised a 50% reduction for their Year 4 zoo excursion 
costs due to their efforts in a zoo fund raising campaign. 
 
Jennifer Dunstan 
Kristy Marshall 
Chris Moor 
Tiffani Price 

RM Billing > Billing Items 

 Double click on the Year 4 Perth Zoo Excursion 

 Select the  Batch Billing Items tab 

 Click Show Outstanding Amounts  (this ensures that the balances 
owing on the billing items after adjustments, if any, are displayed) 

Note:  The ‘Add/Remove Discount for selected items’   remains available when 
selecting ‘Show Outstanding Amounts’ or ‘Show All Transactions’ 

 Click on the Student/Cust header to sort alphabetically 

 Highlight the four students (Hint: Hold CTRL key) 
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 Click Add/Remove discount for selected items   

 Enter 50 as the discount percentage 

 Enter a reason for the discount (July 2019 - Zoo Fundraising) 
 

 
 

 Click OK 

 View the Discount column, the Balance column and the Reason Column 
 

 
 

 

IMPORTANT: The month and year must be entered in a consistent 
manner at the start of the reason for the discount. 

  This is so the Transaction Summary report can be sorted via reason 
containing the month and year. This is most useful for end of month 

reporting. 
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Activity: Review of Applying Discounts 
 
1. Fleur Caterer has started at the school half way through the year.  Discount her voluntary 

contributions by 50%. 
 
 
 
2. Katherine Loxton will be supplying her own transport to and from the Year 6 camp.  Discount 

this item by 100%. 
 
 
 

 
 

10.4 Reporting on Discounts 

The Transaction Summary Report can be used to report on discounted items. 
 

Activity: Report on Discounts 
 
Create a report detailing all items which have been discounted throughout the year. 
 
RM Billing > Reports 
 

 Open the Transactional Reports folder 

 Select the Transaction Summary 

 Delete the default dates 

 Select the Billing Options tab 

 Place a tick in the ‘Show discounted billing items only’ box 
 

 
 

 Click Print and OK 
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 View and close the discount report 
 
Produce the report to show only items which were discounted this month.  This is a mandatory 
report and is required to be printed at the end of each month. 
 

 Select the Other tab 
 

 
 

 In the Reason containing type the month (as you entered) and the year 2019  
 

 
 

 Click Print 
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All the discounts for the selected month are displayed 
 

 
 

 View and close the report 

 Close the Reports window 
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11  Producing Statements 

11.1 Producing Statements for Students 

In RM Billing an individual statement can be produced for each student.  Student statements can 
be accessed from two places: 
 

Students > For Selected > Print Statement  

Reports > Financial Reports > Statement – Students  
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11.1.1 Producing a Statement via the Students section 

 

Activity: Print a Statement 
 
Produce a statement for all Kindergarten students. 

RM Billing > Students 

 Sort by Year group 

 Select all the Year K students 

 For Selected > Print Statement 

 Click OK and OK to print to screen 
 

 
 

 The ‘From’ date will default to the first day of the current month. All transactions from this 
date onwards will be listed on the statement. Any transactions dated prior to this date will be 
summarised in an ‘opening balance’ figure. If this is the first statement you are sending to the 
parent/guardian then it is advisable to enter an earlier date so that all transactions for the 
current year are listed.  For training leave the default date 

 The ‘To’ date will appear blank but will default to today’s date if left blank. Otherwise an end 
date may be entered. Transactions dated after the ‘To’ date will not be included on the 
statement.  Leave this date blank for training 

 The default message that you entered in the Billing Parameters section will be displayed. 
This can be edited at this point if required but the changes will be used for this statement run 
only and will not be saved down.  Leave the default message for training 

 Click OK 

 Scroll down the statements.  Notice that discounts are displayed where they have been given 

 View the summary table at the bottom of each statement.  This will categorise ALL amounts 
outstanding, (regardless of the dates you may have entered for the date range), by billing 
year and category 

 

 Close the statements 

 Close the students window 
 

Note: This method can also be used to print statements for individual students. 
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11.2 Statements for Outstanding Debtors 

If desired, statements can be produced only for students with outstanding debt. 
 

Activity: Statement for Outstanding Debt 
 
Produce a statement for each student with outstanding debt. 

RM Billing > Students 

 Click on the Balance heading twice to bring those students with outstanding balances to the 
top of the list 

 Highlight the students with a balance > 0 
 

 
 

 Click For Selected > Print Statement 

 Click OK and OK to print to screen 

 View and close the statements 

 Close the students window 
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11.2.1 Saving Statements 

Periodically Schools may send out statements to follow up on outstanding student debt.  A record 
of families to whom statements have been sent, should be saved to the G drive in a designated 
folder saved within the Audit Reports folder G:\Audit Report\Student Statements. 
 

Activity: Print and Save Student Statements 
 
We will print Statements for Year 6 students with outstanding balances. 

RM Billing > Students 

 Click on Student Find   

 Select the Year 6 students 

 Click on Find, Select and Yes 

 Click on the Name header to sort the students into alphabetical order 

 Click on   

 Select to print the list of students to screen 

 View then close 

Note:  A list of students to whom statements have been sent must be printed. This list is 
to be signed by the Principal and the report filed. 

 Highlight the students 

 For Selected > Print Statement 

 Change the From Date to 1 FEB 2019 
 

 
 

 Click OK 

 Select Report Destination   

 Click OK 
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To Save the Report 

 Click  Save   

 For training Save to the Desktop 
 

 
 

 Name the file  
 

 
 

 Click OK 

Note: At school users will navigate to G:\Audit Reports\Statements. 

 Print the Statements 
 

 Click   

 Select the required printer and OK.  
 

Note: In training we will not be able to print the statements to a printer 
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11.3 Producing a Statement via the Reports section 

Activity: Printing Student Statements via Reports 
 
Print a statement for all Year 6 students. 

RM Billing > Reports 

 Open the Financial Reports folder 

 Select the Statement – Students 

 The Date range and the default message operate as described in the previous section 
 

 Click  

 Select Year 6 

 Click Find, then Select and Yes 

 The default message entered in the Billing Parameters section is displayed. If required, the 
message can be edited, but the changes will only be for this statement and will not change 
the message in Billing Parameters.   Leave the default message for training 

 

 
 

 Click Print 

 View the displayed statements 

 Close the statements 

 Close the reports window 
 

 

11.4 Family Statements 

Family statements (i.e. one statement which lists transactions for all siblings in the family) cannot 
be produced in this version of RM Billing. 
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12  Receipting 
All receipts entered into RM Billing must be placed into a receipts batch.  Receipts batches must 
be created before the receipts are entered.   
 
The following conventions should be followed when creating receipts batches.    
 

12.1 Separate Receipts Batches 

Create separate batches for the following options: 
 

 General Banking (daily takings – cash and cheques) 

 Electronic Funds Transfers which include electronic credit card payments 

 Direct Deposits such as payments from Centrelink or Family and Children’s Services 

 BPAY 

 Corrections  

 Refunds (Manual Chq, System Chq and EFT) 

 Government Subsidies (special type of receipt – not exported) 
 
It is important that you separate the different types of receipts. This will make reconciliation in RM 
Finance much easier.  
 
For example, a general banking batch containing cash and cheques should be closed off when you 
are ready to bank the money. The batch total in RM Billing (which is transferred to RM Finance) will 
match the deposit amount you take to the bank. When you reconcile in RM Finance, the same 
batch total will appear on the bank statement and also in RM Finance making it easy to reconcile.  
 
If you enter other types of receipts into the batch which are not banked your batch total in RM 
Billing and RM Finance will not match what is on the bank statement. 
 

12.2 Naming Receipts Batches 

The Receipts batch number will be automatically created by RM Billing. It will always begin with the 
letter ‘B’ followed by a sequential 5 digit number beginning with 00001.  
 
When naming a receipts batch the description should contain the type of batch and the date it was 
created (dd.mm.yy). 
 
For example: 
General Banking 18.02.19 
Electronic Funds Transfer 18.02.19 

Note:  For receipts entered retrospectively from receipt books or Z tapes enter the comment 
“Duplicate- original receipt #xxxx” or “Duplicate-original Z tape #xxxx” as required   

For more information log on to http://det.wa.edu.au/finance/detcms/portal/  to access 
“Procedures for RM Billing Receipts batches.” 

  

http://det.wa.edu.au/finance/detcms/portal/
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12.3 Receipt Payment Types 

The following standard payment types exist in RM Billing and need to be used when entering 
receipts onto the system. 
 
CA  Cash 
CH Cheque 
CR Credit Card 
EF EFTPOS 
BP BPAY 
DD Direct Deposit 
GV Government Subsidies 

12.4 Methods of Receipting 

There are a number of different methods that can be used for entering receipts into RM Billing.  
The method used will depend upon the circumstances. 

12.4.1 Receipting Methods 

There are four methods users may select from when processing receipts.  Each has features to 
assist users with individual receipting needs. 
 

Receipt 
Process 

 Features Type of Payment 

Apply Subsidy 
(Secondary 
Only) 

Students>For 
Selected>Apply Subsidy 

Payment is 
automatically 
allocated to billing 
items according to 
business rules 

GV only 
$235 Education 
Program Allowance only  
 

Apply Receipt Students>For 
Selected>Apply Receipt 

Payment is 
automatically 
allocated to billing 
items according to 
business rules 

CA, CH,CR,EF,BP,DD 

Add Receipt Student Record>Add 
Receipt 

Payment is 
automatically 
allocated to billing 
items.  Users may 
edit allocations. 

CA, CH,CR,EF,BP,DD 

Bulk Receipts Receipts>Receipt 
batch>Bulk Receipts 

Allows users to 
receipt via 
payment type. 
Users select the 
billing items to be 
paid. 

CA, CH,CR,EF,BP,DD, 
GV 
 
Ensure correct payment 
batch type is selected 

Add Receipt for 
selected Billing 
Items 

Billing Items> Batch Billing 
Items> Show Outstanding 
Balances> Add Receipt 

Allows users to 
receipt payments 
of the same billing 
item, amount and 
payment method. 

CA, CH,CR,EF,BP,DD 

Note: Payment type GV is only used for receipting the $235 Education Program Allowance 
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Activity: Creating a Receipts Batch 
 
Create the following two receipts batches using today’s date. 
 

 General Banking dd.mm.yy 

 Electronic Funds Transfer dd.mm.yy 
 

RM Billing > Receipts 

 Click Add Item  

 Enter the description and today’s date 
 

 
 

 Click OK 
 

 Create an Electronic Funds Transfer Receipts Batch using the instructions above 
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12.4.3 Original/Draft/Copy text on Receipts 

To obtain an original receipt, the receipt must be printed directly to the printer (not to the screen 
and then to the printer).  Receipts printed directly to the printer for the first time will contain no 
additional text.  Receipts viewed to the screen will contain the text ‘DRAFT’. If sent to the printer 
from the screen, the printed copy will contain the text ‘DRAFT’.  Receipts printed to the printer for 
the second or subsequent time will contain the text ‘COPY’. 
The above is an important audit consideration as there should only ever be one original receipt 
created. 
 

12.4.4 Bulk Receipting for the same Billing Item (via the Billing Items batch) 

This method is useful if a group of students are all paying the same amount for the same billing 
item(s).  For example, a group of students are all paying $250 for their Camp Charges. 
 
The Payment Type (e.g. Cash or Cheque) must also be the same for each group entered. 
 

Activity: Entering Bulk Receipts for the same Billing Item 
 
The following students have all paid in full for their Camp Charges. Follow the instructions below 
to enter these receipts in bulk via the Billing Items batch. 
 

Name Payment Type Amount Paid 
 

Kate Ellard CHEQUE 250 

Keith Jones CHEQUE 250 

Martin Luck CHEQUE 250 

Tamara Murphy CHEQUE 250 

Total Amount Paid 1000 

 

RM Billing > Billing Items 

 Double-click on the Year 6 Camp batch 

 Click on the Batch Billing Items tab 
 

 Click  (this ensures that the balances owing on the billing items after 
adjustments, if any, are displayed) 

 

 Sort by the Student column 
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 Highlight all the billing items for the students who are listed in the table above 
 

 
 

 Click Add Receipts  for the selected Billing Items 

 <Tab> and select the General Banking batch 

 <Tab> to the Amount and enter 1000 (this is the selected total) 

 Enter the payment type of Cheque or press <tab> for a list 

 Enter a comment (e.g. Year 6 Camp) 
 

 
 

 Click OK 
 

 
 

 Click Yes 
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 Select Receipts 

 Click OK and OK to print to screen 

 View and close the receipts 
 

 

To print receipts at another time:  

 Choose Students  

 Select the appropriate student 

 Choose the Receipts tab 

 Select the appropriate receipt in the top half of the window 

 Choose the Printer icon  
 
 
 

Activity: Review of Entering Bulk Receipts for the same Billing 
Item 
 
Use the same method to enter the receipts for those students who have paid by cash for the 
camp. Print the receipts to the screen. 
 

Name Payment Type Amount Paid 
 

Mark Mills CASH 250 

Mason Richards CASH 250 

Josh Tep CASH 250 

Total Amount Paid 750 
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12.4.5 Entering Bulk Receipts for Charges and Contributions (via Students) 

This method is useful if a group of students are all paying the same amount for charges and 
contributions.  The system will automatically allocate the entered amount to each student to pay 
off their Billing Items in a specified order, according to regulations.  If the amount of the receipt is 
greater than the amount owing for the specified categories, then the additional amount will become 
unallocated credit (i.e. a credit amount which not assigned to any billing items). 
 
Billing Items will be paid off in the following order:   
 

Student Billing Category Priority for applying receipts 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Charges, Residential, Voluntary, Other Optional Costs, 
Voluntary Approved Requests followed by any other 
item which has a category assigned including Not 
Applicable.   

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any 
other item which has a category assigned including 
Not Applicable. 

Adult Students Adult Student Fees, Charges, Residential, Other 
Optional Costs, Voluntary Approved Requests followed 
by any other item which has a category assigned 
including Not Applicable. 

Full Fee Paying Overseas 
Students 

Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 
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Activity: Entering Bulk Receipts for Charges and 
Contributions (via Students) 
 
The following students have all paid $40 for their Charges and Contributions. The payments 
have been processed via EFTPOS.  Enter receipts for the student payments in the table below.   
 

Student Payment 

Luke Andrews 40.00 

Charmaine Avery 40.00 

Reuben Baker 40.00 

RM Billing > Students 

 Highlight the students listed in the table above 

 Click Hide Unselected   

 Highlight the students 
 

 
 

 Click For Selected > Apply Receipts  

 <Tab> and select the Electronic Funds Transfer receipts batch 

 <Tab> to the Amount and enter 40 (the amount that will be applied to each student) 

 <Tab> and select the payment type of EFTPOS 

 Enter a comment (e.g. Charges and Contributions) 
 

  
 

 Click OK 

IMPORTANT: 

The amount entered will be applied to each student record.  Therefore, 
this functionality can only be used when each student has paid the 

same amount. 
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12.4.6 Printing receipts for items which have been receipted in bulk 

Receipts can be printed via the receipts batch for items which have been receipted in bulk. 
 

Activity: Print Receipts for Bulk Entries 
 
Print receipts for Luke Andrews, Charmaine Avery and Reuben Baker for the payment for their 
Charges and Voluntary Contributions. 

RM Billing > Receipts 

 Double-click on the (EFTPOS) batch 

 Choose the Batch Receipts tab 

 Highlight the receipts to be printed at the top of the screen 
 

  
 
The payments are displayed in the bottom screen 
 

 Click Print  

 Click on Yes to Print Receipts 

 Click OK 

 View and close the receipts 

 Close the receipts window 

Note: To view what items each receipt has paid, click on each receipt individually. 
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Activity: Review of Entering Bulk Receipts via Students 
 

 The following students have all paid $40 for their Charges and Contributions. The payments 
have been processed via cheque.  Enter receipts for the student payments in the table 

below.  (Hint: Click ) 
 

Student Payment 

Penelope Allen 40.00 

Ross Barbour 40.00 

Tanya Born 40.00 

 
 

 Print receipts for these students. 
 
 

 

12.4.7 Bulk Receipting for a mixture of items via the Receipts batch 

This method is useful for processing a group of receipts which are mixed in nature. For example, 
different students are paying different amounts with various payment types for different items. 
 

Activity: Entering Bulk Receipts for a Mixture of Items 
 
The following payments have been received. Enter these receipts via Receipts > Bulk Receipts.  
Print receipts for the students. 
 

Name Amount Paid Payment 
Type 

Payment For 

Kyle Amber $10 Cash Science Incursion 

Benn Kinnane $40 Cheque Pre-Primary Voluntary 
Contributions 

Elizabeth Williett $20 Cash Year 4 Perth Zoo Excursion 

Doyen Bailie $40 Cheque Primary Voluntary Contributions 

 

RM Billing > Receipts 

 Double-click the General Banking receipts batch 

 Select the Bulk Receipts tab 

 Click Add  

 Enter the student’s surname (or part thereof) in the Student Name field and <tab> to select 
the student from a list 

 Enter the amount and <tab> 

 <Tab> in the items field 

 Highlight the items to be paid, click OK and <tab> 

 Enter the payment type (or <tab> for a list) and <tab> to the comment field 

 Enter a comment (e.g. Incursions) 

 <Tab> to move to the next line  

 Repeat this process using the table above  
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 Click OK 

 Click Print    
 

 
 

 Select Receipts 

 Click OK and OK to print to screen 

 View and close the receipts 

 Click Return to View   
 

Note: A blank line can be removed by right clicking on the line and select ‘Remove line’  
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IMPORTANT  

Receipts are not saved until the ‘OK’ button at the bottom of the screen 
is clicked. It is therefore recommended that shorter lists are entered and 
saved regularly to minimise loss of data in the event of a power failure. 

Activity: Review of Entering Bulk Receipts for a Mixture of 
Items 
 

 The following payments have been received. These payments were all received via EFTPOS 
therefore they must be entered into the Electronic Banking receipts batch.  Enter these 
receipts via Receipts > Bulk Receipts. 

 

Name Amount Paid Payment 
Type 

Payment For 

Cassie Brood $75 EFTPOS Balance of account 

Haley DeSilva $250 EFTPOS Year 6 camp 

Tamara Allen $55 EFTPOS Primary Vols and Ipad Replacement 

 
 
 
 

 
 
 

 
 
 

 Print receipts for these students. 
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12.4.8 Entering an Individual Receipt 

This method can be used to enter a receipt for an individual student. 
 

Activity: Entering an Individual Receipt 
 
Mr James Elliott, Katherine Elliott’s grandfather wishes to pay with a cheque for $40 for her   
Voluntary Contributions.  Enter the receipt into RM Billing. 

RM Billing > Students 

 Double-click on the record for Katherine Elliott 

 Select the Receipts tab 

 Click   

 Press <tab> for a list of open receipts batches 

 Select the General Banking batch for today 

 Press <tab> to move to the Payment Type field 

 Press <tab> for a list of valid payment types (or type the code if you know it) 

 Select Cheque 

 Enter $40 as the amount and press <tab> 

 Enter a comment (e.g. Voluntary Contributions) 
 

 Edit the title to read: Mr 

 Edit the First Name to read: James 

 Edit the Address to 54 Lois Lane 
 

 
 

 Click OK to save 
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Note: The receipt is allocated against the billing items from the top down. This can be 
changed if you need to pay off a specific billing item only.  We will look at this later in 
training. 

The ‘Received from’ fields on the Add Receipt screen show the name of the current fees 
biller for the student. If someone else is paying the money, these fields should be edited to 
contain the name and address of that person. These details are saved with the receipt. 

12.4.9 Printing an Individual Receipt 

Activity: Printing an Individual Receipt 
 
Print a receipt for Katherine Elliot for her payment of Voluntary Contributions. 

RM Billing > Students  

 Highlight the receipt on the Receipts tab for Katherine Elliot 
 

 
 

 Click Print   

 Select Receipts 
 

 
 

 Click OK and OK to print to screen 

 View and close the Receipt 
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12.4.10 Entering an Individual Receipt for more than one billing item 

Activity: Individual Receipts for a Number of Billing Items 
 
Troy Dean has $50 cash to pay for his voluntary contributions and Science incursion.  Enter and 
print a receipt and receipt allocation for Troy. 

RM Billing > Students 

 Right click in the Surname field and type in Dean and <Enter> 

Note:  Ensure the receipt is not highlighted, as this will prevent you from selecting the 
next student. Deselect the receipt and then right click in the Surname field. 

 Ensure the Receipts tab is selected 
 

 Click  

 <Tab> in the Batch No. field and select the General Banking Receipts Batch <tab> 

 <Tab> in the Payment Type and select Cash <tab> 

 Enter 50 in the Amount <tab> 

 Enter the Comment - Primary Voluntary Contributions and Science Incursion 
 

 
 

 View the Applied column and notice that the payment has been automatically applied from 
the top down and has been applied against the Primary Voluntary Contributions and the IPad 
Replacement batch and not the Incursions Billing Item. 
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 Delete the $10.00 that has been applied to the IPad Replacement billing item 

 <Tab> down to the Incursions billing item 

 Enter 10 in the applied column <tab> 
 

 
 

 View the figure at the bottom of the applied column and ensure it matches the Amount figure 

 Click OK 
 

 Highlight the receipt 
 

 
 

 View the details of the receipt in the lower details section of the screen 
 
 



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 100 of 277 

© 2019 Civica Pty Ltd 

 

 
 

 Click Print  

 Select Receipt 
 

 
 

 Click OK 

 View and close the receipt 
 

 Click Print  

 Select Record of receipt allocations 

 Click OK 

 View and close the record of receipt allocations 
 

 

Note: The official document is the ‘Receipt’. This is what should be printed and given to the 
parent.  

The ‘Record of Receipt Allocation’ can also be printed if required. This lists the billing items 
to which the receipt is currently allocated. Note that the allocations for a receipt can change 
if paid billing items are reversed or adjusted or if unallocated credit is allocated. 

 

Activity: Review of Entering Individual Receipts 
 
1. Natasha Price has brought a cheque for $55 to pay for her voluntary contributions and the 

IPad Replacement voluntary approved request.  Enter and print a receipt for Natasha. 
 
2. Nora Chum has brought $250 cash to pay for the Year 6 Camp.  Enter and print a receipt for 

Nora. Also print the Record of Receipt Allocations 
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12.5 Reporting on Receipts 

Reports available for receipts include: 

The Daily Banking Summary 

This report is useful in reconciling the daily takings. It will separate the transactions by payment 
type (e.g. Cash and Cheque) and give overall totals. 

The Receipts Summary 

This report will group all receipt allocations by analysis code, budget code and GST code. It is 
used for manual input of transactions into RM Finance. 
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Activity: Printing the Daily Banking Summary 
 
Print the Daily Banking Summary for the General Banking receipts batch for today. 

RM Billing > Receipts 

 Highlight the General Banking receipts batch 

 Click For Selected > Print Daily Banking 
 

 

 

 
 This report can be used to check calculations of the Totals to be banked 

 Print a paper copy of the report and file it (This is a mandatory report) 

 View and Close the Daily Banking Summary 
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Activity: Printing the Receipts Summary 
 
Print the Receipts Summary for the General Banking receipts batch for today. 

RM Billing > Receipts 

 Highlight the General Banking receipts batch 

 For Selected > Print Receipts Summary 

 Click OK to print to screen 
 

 
 

 Click Yes to print the Detailed Summary (This is a mandatory report) 
 

A portion of the report is shown below 
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Note:  The Receipt Summary Detailed Report must be printed and filed with the monthly 
reports. 

 View and Close the Receipts Summary 
 

Print the Totals Only report 
 

 For Selected>Print Receipts Summary 

 Click OK to print to screen 

 Click No to print Totals Only 
 
A portion of the report is shown below 
 
 
 

 
 
 
View and close the Receipts Summary Report (we will use this again later in training when 
transferring information from RM Billing to RM Finance). 
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Activity: Review of Reporting on Receipts 
 
1. View the Daily Banking for the Electronic Funds Transfer receipts batch. 
 
 
 
 
 
2. View the Receipts Summary for the Electronic Funds Transfer receipts batch. 
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13 External Customers 
An External Customer may be anyone the school deals with who is not a student or a 
parent/guardian – i.e. companies or individuals outside of the school environment. 
 
External customers have their own section in RM Billing on the side bar. Unlike students, the 
customer details are not drawn from the Integris datafile. All Customer Details need to be entered 
manually into RM Billing. 
 
The main differences between Customers and Students are that customers are not linked to 
Timetabling (so there is no subject billing) and there are no bulk processes (such as bulk billing 
and bulk receipting) designed for customers. The functionality available in the Customers section is 
very similar to that in the Students section. Double-clicking on a customer record or highlighting the 
customer and pressing <enter> will invoke the drill down facility and many of the same tabs are 
available. 

13.1 Create External Customer 

Activity: Create External Customer 1 
 
The local theatre group – West Coast Theatre, are interested in hiring out the school hall for their 
after school rehearsals. The school has agreed that they are able to lease the hall in Term 1 for 
a total of $1045.00 (including GST).  Set up the details for West Coast Theatre. 
 

RM Billing > Customers 

 Click Add Customer   

 Enter the details as shown below and Click OK to save 
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Activity: Create External Customer 2 
 
Oceanview Tennis Club has enquired about hiring the school’s tennis courts for four weeks 
interim coaching lessons while the district’s tennis club courts are being re-surfaced.  We have 
agreed to 3 afternoons per week at $80 (Inc GST) per session for which they will pay weekly in 
advance.  Set up the details for Oceanview Tennis Club. 

RM Billing > Customers 

 

 Click Add Customer   
 

 Enter the details as shown below and Click OK to save 
 

 
 

 
 

 Close the Customer window 
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13.2 Customer Billing 

Customers are billed in the same way as students – a Billing Items batch needs to be created. 
 

13.2.1 Create a Billing Items Batch 

Activity: Create a Billing Items Batch for West Coast Theatre 
 
Create a Billing Items batch for Hire of Facilities as illustrated below. 

RM Billing > Billing Items 

 Click Add Item   

 Enter the description of West Coast Theatre-Hall Hire 

 Click OK 

 Click Add Debit  

 Enter the comment 2019 Hall Hire Term 1 Weeks 1-5 <tab> 

 Enter the amount 550 <tab> 

 Enter the GST code of 1 <tab> 

 <Tab> and select the Billing Code HIR01 

 Click OK 

 Repeat for 2019 Hall Hire Term 1 Weeks 6-10 for $495.00 
 

 
 

 Click    Return to View 
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Activity: Create a Billing Items Batch for Oceanview Tennis 
Club 
 
Create a Billing Items batch for the hire of the Tennis Courts as illustrated below. 

RM Billing > Billing Items 

 Click Add Item   

 Enter the description of Oceanview Tennis Club - Hire of Tennis Courts 

 Click OK 

 Click Add Debit  

 Enter the comment 2019 Tennis Court Hire Week 1 <tab> 

 Enter the amount 240 <Tab> 

 Enter the GST code of 1 <Tab> 

 <Tab> and select the Billing Code HIR01 

 Click OK 
 

 
 

 Close the Billing Items window 
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13.2.2 Bill the Customer Using the Batch 

Activity: Bill West Coast Theatre 
 
Bill the Customer ‘West Coast Theatre’ using the Hire of Facilities batch. 

RM Billing > Customers 

 Double-click on West Coast Theatre 

 Select the Billing Items tab 

 Click   

 Choose the Hall Hire batch from the list displayed 
 

  

Note:  When adding a billing item to a customer, the user has the ability to edit the details 
of the billing item.  This is consistent with the functionality that currently exists for adding 
/editing a billing item for a student. 

 Click OK 
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 Click on the Customer Name of West Coast Theatre in Red 
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Activity:  Bill Oceanview Tennis Club 
 
Bill the Customer ‘Oceanview Tennis Club’ using the Hire of Tennis Courts batch. 
 

RM Billing > Customers 

 

 Click   

 Choose the Hire of Tennis Courts batch from the list displayed 
 

 
 

 Click OK 
 

 
 
Keep the window open 
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13.3 Customer Invoices 

A tax invoice is automatically created whenever a customer is billed.  
 

Activity: View a Tax Invoice 
 
View the Tax Invoice which has been automatically created for West Coast Tennis Club 

RM Billing > Customers 

 Click on the Invoices tab 

 Highlight the Invoice which is listed 
 

 
 

 Click Print  

 Click OK to the Invoice message and OK to Print to Screen 

 View and close the Invoice 

 Double click on West Coast Theatre 

 Click on the Invoice tab 

 Highlight the Invoice which is listed 

 Click on Print  
 

Leave the window open 
 

Note: This tax invoice is fully compliant with government regulations. 
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13.3.1 Open/Closed Invoices 

If an invoice has not been sent directly to the printer it is considered to be ‘open’.  This means that 
if more billing items are added to this customer they will be added to this open invoice.  Once the 
invoice is sent straight to the printer it is automatically closed.  If additional billing items are added 
to the customer once an invoice is closed a new invoice will be created for these items.   
 

13.3.2 Draft/Copy/Amended text 

To obtain an original invoice, the invoice must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Invoices printed directly to the printer for the first time will contain no additional text. They will also 
be ‘closed’ by printing them straight to the printer (see above). 
 
Invoices viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. 
 
Copies of invoices printed to the printer for the second or subsequent time will contain the text 
‘COPY’. 
 
Invoices may also contain the text ‘Amended’ followed by a date. If an invoice is amended (i.e. 
changes are made to the billing items attached to the invoice once it has been closed) then an 
amendment number will be attached to the original invoice number (e.g. 36-1). The invoice will 
contain the ‘Amended’ text and the date of amendment. It is possible for an invoice to be amended 
more than once. Invoices will be amended if the billing items attached to them are reversed, 
adjusted or discounted once the invoice is closed. 
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13.4 Receipting for Customers 

Individual receipts can be created for a particular customer. This is done via the Customers section 
by drilling down on the Customer record and going to the Receipts tab. 
 

Activity: Add a Customer Receipt for West Coast Theatre 
 
West Coast Theatre has paid in full for the hall hire.  The money has been paid directly into the 
bank using EFTPOS via the schools on-site machine.  Print a copy of the receipt for West Coast 
Theatre. 

RM Billing > Customer 

 Select the Receipts tab 

 Click Add Receipt   

 <tab> in the Batch No field and select the Electronic Funds Transfer batch 

 Enter the payment type of EF or <tab> for a list 

 Enter the amount of 550 

 Enter a comment  Hall Hire Term 1 Weeks 1-5 

 Check that the applied amount is correctly allocated in the lower window 
 

  
 

 Click OK 

 Highlight the receipt and click Print  

 Select Receipts > Click OK and OK to print to screen 

 View and close the receipt 

 Click    Return to View 
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Activity: Add a Customer Receipt for Oceanview Tennis Club 
 
Oceanview Tennis Club have also paid in advance for their first week of tennis court hire with a 
cheque for $240.  Process the receipt for Oceanview Tennis Club. 
 

 Double Click on Oceanview Tennis Club 

 Select the Receipts tab 

 Click Add Receipt  

 <Tab> in the Batch No field and select the General Banking batch 

 Enter the payment type of CH or press <Tab> for a list 

 Accept the default date 

 Enter the amount of 240 

 Enter a Comment  Tennis Court Hire Week 1 
 

 
 

 Click OK 

 Highlight the receipt 

 Click Print  

 Select Receipts > Click OK and Ok to print to screen 

 View and close the receipt 
 

Note:  The user may edit the Received from: field which is consistent with the 
functionality that currently exists in the student Receipt Details window 

 
Keep the window open 
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13.5 Customer Statements 

Statements for customers can be printed from the Reports section as follows. 
 

Activity: Print a Customer Statement 
 
Print a statement for West Coast Tennis Club and West Coast Theatre 

RM Billing > Reports 

 Open the Financial Reports folder 

 Select the Statement – Customers report 

 The date range and the message operate as outlined in the student statement 

 Click Find Customer   
 

 

Note:  It is possible to search for a customer using the customer name field and the 
search button. 

 Highlight both customers 

 Accept the default settings  

 Click Print and OK to print to screen 

 View and close the Statement 

 Close the Reports window 
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14 Recap of Day One 

Activity: Day One Recap 
 
Write down the steps or path you would take to: 
 
1. Set General Parameters to the RM Billing module such as the default statement message. 
 
 
 
 
 
2. Create a new Billing Code in RM Billing. 
 
 
 
 
 
 
3. Set a Student Billing Category. 
 
 
 
 
 
 
4. Create a Billing Item. 
 
 
 
 
 
 
 
5. Bulk bill students for a billing item. 
 
 
 
 
 
 
 
6. Individually bill a student for a billing item. 
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7. Apply a discount to a billing item for a student. 
 
 
 
 
 
 
8. Produce a statement for a student. 
 
 
 
 
 
9. Enter receipts in bulk via the billing items batch. 
 
 
 
 
 
 
10. Enter bulk receipts which are mixed in nature. For example, different students are paying 

different amounts with various payment types for different items. 
 
 
 
 
 
 
11. Print the Daily Banking Summary for a receipts batch. 
 
 
 
 
 
 
12. Print the Receipts Summary for a receipts batch. 
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15 RM Billing & RM Finance Interface 
 
All receipts (except Government Subsidies for Secondary School students) which are entered into 
RM Billing need to be transferred to RM Finance where the reconciliation will take place. If you 
follow the receipting processes outlined in these notes then the reconciliation in RM Finance 
should be relatively straight forward. There are two ways in which the receipts can be transferred: 
 

 Manual input to RM Finance using summary reports produced from RM Billing 

 Automatic export to RM Finance using the inbuilt export routine 

Note: It is recommended that Primary Schools begin using the automatic export. It is 
however important that Users understand the manual process of inputting receipts batches 
into RM Finance as this gives insight into how the automatic export works.  We will look at 
both methods in this training course. 

15.1 Manual Input of Receipts to RM Finance 

We will look at how to transfer the contents of the General Banking batch manually into RM 
Finance. This should be done when you are ready to finalise the banking and close off the 
batch – i.e. no further receipts should be input into the batch once this process has commenced. 
 

15.1.1 Print Daily Banking Summary and Transfer Information to the Batch Register 

Firstly the Daily Banking Summary must be printed and the information from the Daily Banking 
Summary written onto the Finance Batch Register. 
 

Activity: Transferring Totals from the Daily Banking Summary 
to the Finance Batch Register 

RM Billing > Receipts 

 Highlight the General Banking batch 

 Click For Selected > Print Daily Banking 
 

 
 
 

 View the printed Daily Banking Summary on the following page 
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 This report can be used to check the calculations of your totals to be banked 

 Print a paper copy of the report and file it 

 Complete the Finance Batch register as outlined below 
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15.1.2 Print the Receipts Summary Report 

The Receipts Summary Report must be printed so it can be used for manual input into RM 
Finance. 
 

Activity: Print the Receipts Summary Report 
 

RM Billing > Receipts 

 Highlight the General Banking batch 

 Click For Selected > Print Receipts Summary 
 

 
 

 Click OK to print to screen 
 

 
 

 Click Yes to print the detailed summary 

 This report should be printed to the printer and filed for reference 
 

Note: Use the Totals only version of the Receipts summary report when manually inputting 
data into RM Finance, however the detailed summary must be printed and filed for 
reference. 
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15.1.3  Close the Batch in RM Billing 

The receipts batch must be manually closed to ensure that no more receipts are processed 
through it.  When a receipts batch is closed it is because the banking is being completed.  A new 
receipts batch can be opened following the same format and using the date of opening (e.g. 
General Banking 18.02.19) 
 

Activity: Manually Close the Receipts Batch  

RM Billing > Receipts 

 Highlight the General Banking batch 

 Click For Selected > Close Batch 
 

 
 

 Click Yes 

 The Print Setup screen appears 

 Check your setting and click OK 
 

 
 

 Click No to get the Totals Only version of the report 

 Go to the printer and check that the report has printed successfully 
 

 
 

 If the report has not printed correctly click on ‘No’. Go back to the start of the ‘Close Batch’ 
process and repeat the steps listed 

 

 If the report has printed correctly click on ‘Yes’ (Warning – the process of closing the batch 
and marking the transactions as posted cannot be reversed).  A working message may 
briefly appear. Then the batch is marked as closed. This means that no further receipts can 
be input into that batch 
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15.1.4 Manually Enter Data into RM Finance 

It is not necessary to enter every single RM Billing receipt transaction into RM Finance. The actual 
transactional details will always be available within RM Billing. For each batch it is necessary to 
enter an overall total for each budget/analysis/GST code grouping.  
 
The ‘Totals Only’ version of the Receipts summary report will be used to input the data into RM 
Finance. This is the report we printed when we closed the batch.  The following 2 pages show a 
copy of this report. 
 
The report is broken up via the various billing codes.  The budget and analysis code is displayed 
for each billing code as is the total for that budget and analysis code.  Receipts which contain GST 
are separated from those which do not have GST. 
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These income lines are entered into RM Finance as per the above report. They are summarised in 
the table below 
 

Inc 
Source 

Reference Batch 
Ref 

Detail Budget Analysis Total Tax 
Code 

INC001 B00001 B00001 School Camps C1102 C1100  1200.00 0 

INC001 B00001 B00001 School Camps C1102 C1100 880.00 1 

INC001 B00001 B00001 Incursions C1103 C1100 20.00 0 

INC001 B00001 B00001 Excursions C1104 C1100 20.00 0 

INC001   B00001 B00001  Hire of Tennis 
Courts 

C1705 C1700 
240.00 

1 

INC001 B00001 B00001 IPad 
Replacement 

C1525 C1500 
15.00 

0 

INC001 B00001 B00001 Primary Voluntary 
Contributions 

C1002 C1000 160.00 0 

INC001 B00001 B00001 Pre-Prim 
Voluntary 
Contributions 

C1003 C1000 80.00 0 
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Activity: Manually input Receipts Batches into RM Finance 
 
The transactions entered into RM Finance for this report would be as follows: 
 

RM Finance 

 Open RM Finance   

 Log in to RM Finance as the Manager Corporate Services with the password of keys 
 
Transactions > Income 

 

 Type INC001 in the Income Source <tab> 

 Type 2615 in the Total <tab> 

 <Tab> to accept the default date 

 Enter the Reference as B00001 <tab> 

 Enter the Batch Ref. as B00001 <tab> 

 Enter the detail as School Camps <tab> 

 Enter C1102 as the Budget code (can <tab> to select this from a list ) <tab> 

 Enter 1200 as the line total <tab> 

 Type 0 as the tax code 
 

  
 

 <tab> twice to drop the information into the All Income Lines section of the screen 
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 Continue entering the income transactions using the table below: 
 

Detail Budget Total Tax Code 

School Camps C1102 880.00 1 

Excursions C1103 20.00 0 

Incursions C1104 20.00 0 

Hire of Tennis Courts C1705 240.00 1 

IPad Replacement C1525 15.00 0 

Primary Voluntary Contributions C1002 160.00 0 

Pre-Prim Voluntary 
Contributions 

C1003 80.00 0 

 

 View  All Income Lines  
 

 
 

 Check to make sure that the line total matches the total up the top of the Income window 
 

  
 

 Click  
 

 Click OK to select the Cheque Account 
 

 
 
 

 
 

 Click Yes to batch the transaction 
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Step 2– Check the Batched Transactions Report 
 

 Click   

 Select the Batched Transactions Report  
 

 
 

 Tick to include transaction types Income and select the Cheque Account 

 Click Print 
 

A portion of the report is shown below 
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Step 3 – Edit the Batch if necessary 
 

 Transactions > View/Post Batch 

 Click on Income 

 Enter B00001 as the Batch reference 

 Click Display  
 

 
 

 To edit the batch highlight the line for B00001 

 Click Edit   
 

 
 

 Select the line to edit in the All Income Lines section 

 Edit the necessary field 
 
We will not edit any lines in training 
 

 <Tab> to clear the Edit selected Income Line section of the screen 

 Click  > OK 
 

 
Step 4 – Post the Batch 
 
Transactions > View/Post Batch 
 

 Click on Income 

 Enter B00001 as the Batch reference 
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 Click Display  

 Click Select All    to change the NO to a YES and view the Total to post of $2615 
 

  
 

 Click  
 

 
 

 Click Yes 
 
Step 5 – Check the result of posting  

Records > Budget Accounts 

 Click  

 Type C1102 in the Budget Account <enter> 
 

 

 Click on the magnifying glass to the right of the Balance Remaining   

 Select Full Budget Analysis  
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 Click Print 
 

 Click OK  
 

 
 

 Click No as you may be looking for transactions outside of the current period 
 

 
 

 Click Yes to show the Transaction Descriptions 

 Follow the printer prompts to Landscape 
 

 View the Budget Analysis Report with the details entered from the Billing Receipts batch 
 

 
 

 Close the Report 

 Minimise RM Finance 
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Activity: Finalise Receipts Batches 
 
Before enabling the Export to RM Finance function, all receipts batches must be finalised in RM 
Billing. There is one batch to finalise – the Electronic Funds Transfer batch. 

RM Billing > Receipts 

 
Step 1 – Print the Daily Banking Summary 
 

 Highlight the Electronic Funds Transfer receipts batch 

 For Selected > Print Daily Banking 

 Print the report and file it 
 

  
 

 Enter the details of the batch onto the Finance Batch Register 
 

 
 

 Close the Daily Banking Summary 
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Step 2 – Print the Receipts Summary 
 

 For Selected > Print Receipts Summary 

 Yes to print the detailed summary 

 Print and file the report 

 Close the receipts summary 
 

 For Selected > Close Batch  
 

 
 

 Click Yes 

 Select the correct printer > OK  

 Check that the report has printed correctly 

 If the report has printed correctly click Yes otherwise click No and begin the process of 
closing the batch again (for training click Yes) 

 

  
 

 Both batches are now closed 
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 Close the Receipt Summary Report 
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Step 3 – Enter the Totals for each Budget and Analysis Code into the Income screen 
 
Maximise RM Finance 
 
Transactions > Income 
 

 Enter the Income Source of INC001 <tab> 

 <tab> to accept the default date 

 Enter the total of 1050 <tab> 

 Enter the Reference of B00002 <tab> 

 Enter the Batch Ref. of B00002 <tab> 

 Enter the detail of School Camps <tab> 

 Enter the Budget Code C1102 <tab> 

 Enter the Line total 180 <tab> 

 Enter the Tax code 0 <tab> twice 

 Continue entering information using the receipts summary or the below table 
 

Detail Budget Total Tax Code 

School Camps C1102 110.00 1 

In Term Swimming C1105 40.00 0 

Hire of Facilities (Hall Hire) C1705 550.00 1 

IPad Replacement C1525 30.00 0 

P&C Family Contribution N3005 20.00 8 

Primary Voluntary Contributions C1002 40.00 0 

Kindy Voluntary Contributions C1004 80.00 0 

 

   
 

 Check the top and bottom Totals are the same 
 

 Click  OK to the Cheque Account and Yes to batch the transaction 
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Step 4 – Check the Batched Transactions Report 
 

 On the Transactions menu click  

 Select the Batched Transactions report 

 Include Income Transaction Types from the Cheque Account 

 Click Print 
 
A portion of the report is displayed below 
 

 
 

 Check the batched transactions report against the receipts summary making sure that the 
correct budget and analysis codes have been entered and the correct GST codes used 

 Close the batched transactions report 
 
Step 5 – Edit the Batch if necessary 
 

 Transactions > View Post Batch  

 Click on  Income 

 Enter B00002 as the Batch Reference 
 

 
 

 Click Display  

 Highlight batch B00002 and click Edit  

 Select the line that needs editing in the All Income Lines section of the screen 

 Edit the required field 

 <tab> to clear the Edit Selected Income Lines section of the screen 

 Click  >OK 
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Step 6 – Post the Batch 
 
Transactions > View Post Batch > Income 
 

 Enter B00002 as the Batch Reference 
 

 
 

 Click Display  

 Click Select All   
 

  
 

 

 Click   
 

 
 

 Click  Yes 

 Close RM Finance 
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15.1.5 Print Re-allocation Transactions 

At times the allocation of receipts may change in RM Billing. For example, a parent may pay some 
money in advance to be used throughout the year. The money is entered in RM Billing as 
unallocated credit. It is then transferred into RM Finance and posted against the suspense account 
(N3199). 
 
Then the student is billed for a camp and the parent instructs for some of the money to be used. So 
the money is now allocated in RM Billing to the Camp billing items for the student. (We will look at 
how to do this a little later in the training course). 
 
What has happened is that the allocations in RM Billing have changed, and therefore a change 
needs to be made in RM Finance to ‘move’ the money out of the suspense account and into the 
appropriate ‘C’ account for the camp. 
 
The ‘Print Re-allocation Transactions’ function produces a Receipts Summary report which lists 
these types of changes only, so that the necessary adjustments can be made in RM Finance. 
 
This report must be printed and the transactions marked as posted before the Export to RM 
Finance can be turned on. 

Note: The end of month procedures require that any budget reallocations are entered into 
RM Finance and marked as posted in RM Billing. 
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Activity: Print Re-Allocation Transactions 
 
Print any re-allocation transactions. 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Highlight the Print Re-allocation Transaction 
 

 
 

 Click Print 
 

 
 

Note: We do not have any re-allocation transactions at this point.  This will be covered 
later in training. 
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 The Detailed report will be printed, followed by the Totals Only report (example below) 
 

 
 
 
 

 Go to the printer and check whether the report has printed successfully 

 The following message is then displayed 
 

 

 
 
 

 If the report has not printed correctly click ‘No’ and restart this process 

 If the report has printed successfully click ‘Yes’ 
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 If ‘Yes’ has been selected then the transactions will be marked as posted and the following 
message will be displayed 

 

 
 

 Click on OK 
 

Note: The transactions will not be marked as posted if the report is printed to the screen. 
In this case the following message will be displayed.  

 
 

 The transactions listed in the report should now be entered into RM Finance as previously 
discussed 

 Close the Reports window 
 
 

Note: The overall total of the Print Re-allocation Transactions report will always be zero. 
This is because it represents the movement of monies between accounts (e.g. debit one 
account and credit another, so the overall effect is zero). In the sample report shown above 
an income correction transaction for $20 would be entered against the suspense account 
(N3199), and an income transaction for $20 would be entered against the C account (C1001).  
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15.2  Enable Export to RM Finance 

Note: It is recommended that Primary Schools start using the automatic export as soon as 
RM Billing is implemented at the school. 

When ready to turn on the ‘Export to RM Finance’ function follow the process outlined below. 
 

Activity: Enable Export to RM Finance 
 
Enable the Export to RM Finance function. 

RM Billing > Parameters > Billing Parameters 

 Click Change Parameters  

 Place a tick in the Enable Export to RM Finance check box   
 

 
 

 Click OK to save 
 

 
 

 Click Yes to enable the link 

 Close the Parameters window 

 Close the Billing Parameters window 
 

Note: An export to RM Finance will be performed later in training when new receipt batches 
have been created. 

 

WARNING  

Once the ‘Enable Export to RM Finance’ function has been turned on it 
cannot be disabled. Do not turn this function on until you are sure you 

are ready to begin exporting automatically. 
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Note:  When attempting to enable the link to RM Finance, the following message may be 
displayed 
 

 
 
To correct the error check the following: 
 

1.  All Receipt Batches have been closed and transactions marked as posted, as 
outlined in these notes. 
 

2. All Re-allocation transactions have been printed directly to the printer and marked 
as posted, as outlined in these notes 
 

3. Close RM Finance and re open it. 
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16 Receipting after Export to RM Finance is Enabled 
There is no change to the receipting process once the Export to RM Finance is enabled.  If the 
banking batches have been closed, new batches must be opened to hold any further receipts. 
 

Activity:  Open New Receipt Batch 
 
As the previous General Banking batch is now closed and the receipts entered into RM Finance, 
a new General Banking batch must be opened to hold any further receipts that are received. 
 
Create the following receipt batch using today’s date 
 
RM Billing > Receipts 
 

 Click Add   

 Enter the description and Today’s date 
 

 
 

 Click OK to save 
 

Note:  An Electronic Funds Transfer batch may also need to be created, but for training 
purposes today, we will only open a General Banking batch. 
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16.1.1 Receipting after export to RM Finance is enabled 

Activity: Receipting After Export enabled 
 
The following students have brought in $20 cash to pay for their Year 4 Perth Zoo excursion.  
They are all paying by cash. 
 

Julie Edwards 

Kristof Farmer 

Thi Reth Gray 

Sarah Sorrell 

 
RM Billing > Billing Items 
 

 Double click on the Year 4 Perth Zoo batch 

 Select the Batch Billing Items tab 

 Click on  

 Click on the Student/Cust header to sort alphabetically 

 Highlight the students who have paid 
 

  
 

 Click Add receipts for the selected billing items   

 <Tab> select the General Banking batch 

 <Tab> to the amount and enter 80.00 
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 <Tab> <Tab> to the payment type and select Cash 

 Enter a Comment  
 

  
 

 Click OK 
 

 
 

 Select Receipts 

 Click OK  
 

 
 

 Click OK to print to the screen 

 View the report and close 
 

 Click  Return to View 
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17  Class Collection Lists  
When collecting money through a Class Collection List, there are two options for receipting the 
money collection.  
Option 1:   Receipt the money against individual students through a Billing Item Batch (Bulk 
Receipts). 
Option 2:  Receipt the money against the class as a Customer.   
 

Activity:  Receipting Money against Individual Students 
 
The Year 1 class are collecting $10.00 for an incursion.  The Class Collection money received, 
will be noted against each individual student and receipted through the billing item batch, by 
selecting the students who have paid for the activity on that day. 

Note: A separate column must be used for each activity 

The following Year 1 students have brought in their money for an incursion. The students were 
billed using the Billing Item batch Year 1 and 2 Science Incursion.  
 
 

Class Collection Year 1 Room 1: 
 

  19/02/19 
Incursion 

  

    

Kristel Marshall 10.00   

Trisha Taleb 10.00   

Simon Swansson 10.00   

Yazeed Jones 10.00   

Lauren Parkey 10.00   

Simon Halligan 10.00   

    

Total 60.00   
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RM Billing > Billing Items 

 Double click on Year 1 and 2 Incursions and select the Batch Billing Items tab   

 Sort by Year Heading 

 Click Show Outstanding Amounts   

 Highlight the Year 1 students who have brought in their incursion money 
 

HALLIGAN: Simon 10.00 

JONES: Yazeed 10.00 

MARSHALL: Kristel 10.00 

PARKEY: Lauren 10.00 

SWANSSON: Simon 10.00 

TALEB: Trisha 10.00 

 
 

  
 

 Select  Add receipts for the selected billing items   

 Tab in the Batch Field and select the General Banking Batch 

 Tab to the Amount enter the selected total $60 

 Enter payment type CA cash 

Note: The RM Billing receipt batch number and receipt date must be recorded on the 
class collection list under the total for each column. 
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 Enter comment  Year 1 Science Incursion 

 Click OK 
 

  
 

 Click Yes to print the receipts 
 

 
 

 Select Receipts 

 Click OK  

 Click OK to print to the screen 
 

 
 
 

 View the report and Close 
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17.1 Receipting Against the Class as a Customer 

Activity: Receipting the Class as a Customer 
 
Some primary schools may choose to use the following method as an alternative to Individual 
Receipting through Bulk Receipts, when a record is not required against each student in RM 
Billing and the amount being taken is relatively small.  Each class can be set up as a Customer 
and the total for each activity for each day can be receipted against the class. 
 
Year 6/Room 6 is collecting $1.00 from each student for a visiting author.  In the class collection 
list, the money received is noted against each individual student.  A separate column must be 
used for each activity. 
 

Class Collection – Year 6 Room 6.  
 

 Visiting 
Author 

 19.02.19 

Baker:  Reuben 1.00 

Barbour:  Ross 1.00 

Born:  Tanya 1.00 

Chum:  Nora 1.00 

Ellard:  Kate 1.00 

Jones:  Keith 1.00 

Loxton:  Katherine 1.00 

Luck:  Martin 1.00 

Mills:  Mark 1.00 

Murphy:  Tamara 1.00 

Richards:  Mason 1.00 

Tep:  Josh 1.00 

 
Total 

 
12.00 

 

RM Billing > Customers 

Prior to receipting, a Customer Billing Items Batch must be created. 
 

 Double Click on Customers 

 Click Add  

 In Line 1, enter Year 6 Room 6  
 

 
 

 Click OK 
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A Billing Items Batch needs to be created in order to Bill Year 6 /Room 6 as a Customer 
 
RM Billing > Billing Items 

 Click Add  

 Enter the Description Year 6 Room 6 Class Activity-Visiting Author  

 Click OK 

 Click Add    and enter the following information as shown below 
 

  
 

 Close Billing Items 
 
The Billing item can now be applied to the Customer 
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RM Billing > Customers 

 Open Customers and Double click on Year 6 Room 6  

 Select the Billing Items tab   

 Click  Add Billing Item   

 Highlight Year 6 Room 6 Class Activity and Click OK 
 

  

Note:  When adding a billing item through the Customer function, the user has the ability 
to edit the details of the billing item.  This is consistent with the functionality that 
currently exists for adding /editing a billing item for a student. 

 The Billing Item is applied in the Customer window 
 

  
 

 
  



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 155 of 277 

© 2019 Civica Pty Ltd 

 

 

 
If a receipt is to be issued, it is added to the customer using the receipt reference CCL (Class 
Collection List - name of activity) and the date of Collection. 
 

 Click on the    tab in the Customer window 
 

 Click Add Receipt   

 <tab> in the Batch No field and select the General Banking Batch 

 <tab> in the Payment Type and select Cash 

 Enter the Total amount of $12.00 

 Enter CCL – Visiting Author and TODAY’S DATE into the Comment Field 
 

  
 

 Click OK 
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 Highlight the receipt in the top section of the window and view the Details of the receipt 
 

  
 

 Close the window 
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17.2 Exporting the General Banking batch to RM Finance 

IMPORTANT     

RM Finance must be closed before exporting.  If not, a message will 
inform the user that there are ‘Too many records to sort’.  Once export 

has been complete, RM Finance can be reopened 

The Year 4 Perth Zoo Excursion and the Class Collections were entered into the General Banking 
Batch.  As the banking has been finalised for the day, the Export to RM Finance Utility can be used 
to transfer the General Banking Batch into RM Finance. 
 
As a batch has been exported, it is automatically closed, so a new General Banking batch will need 
to be created to hold the next day’s takings. 
 
The same steps for the manual input are also carried out for the automatic export.  The Daily 
Banking must be printed along with the Detailed Receipts Summary and Totals Only reports 
 

Activity: Exporting the General Banking Batch into RM Finance 
 
Automatically export the General Banking Batch to RM Finance 
 
Step 1 – Print the Daily Banking Summary 

RM Billing > Receipts 

 Highlight the General Banking Batch 

 Click For Selected > Print Daily Banking 
 

 
 
 

 Print a paper copy of the report and file it 
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 Fill in the Finance Batch Register using the Daily Banking Summary 
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RM Billing > Receipts  

 Highlight the General Banking Batch 

 For Selected > Print Receipts Summary 

 Click Yes to print the detailed summary 

 Print and file the report 

 Close the receipts batch window 
 
 
Export the General Banking to RM Finance 
 

RM Billing > Utilities 

 Double click Export to RM Finance 

 Click Yes to the message to export the transactions 
 

 Highlight the General Banking Batch 
 

  
 

 Click OK  

 Check the settings on the Print Setup screen and click OK (do not Cancel at this stage, 
otherwise transactions will not be exported) 

 

 
 

 Click OK once the Export is Complete 

Note:  If the error message ‘Too many records to sort” is received, then RM Finance must 
be closed before exporting batches from RM Billing. 
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The Export Summary Report will be sent straight to the printer. There is no provision to send it to 
the screen. The report must be signed by the Principal and filed with the monthly reports.  A 
copy of the report is shown below. 
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17.3 Check and Update the Transaction in RM Finance 

It is now necessary to update the transactions that have been automatically exported from RM 
Billing to RM Finance. 
 

Activity:  Update the Exported Transactions in RM Finance 
 
Step 1 – Check the Batched Transactions Report 
 

RM Finance > Transactions 

 

 Login to RM Finance 

 Highlight Manager Corporate Services 

 Enter Password Keys 
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Transactions > Reports 
 

 Select  

 Select the Batched Transactions Report 

 Select Income only 

 Select the Cheque Account only 
 

 
 

 Click Print 
 

 
 

 Check the report against the Receipts Batch Export Summary 

Note:  The Receipts Batch Export Summary cannot be printed to screen, but can be re-
printed from Reports > Audit Reports > Re-Print Receipts Export Summary. 
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Step 2 – Update the Income Batch in RM Finance 
 

Transactions > View /Post Batch 

 

 Select Income 

 Enter the Batch Reference B00003 
 

 
 

 Click Display   

 Click Select All   
 

  
 

 Click    

 Click Yes 
 
 

 Close RM Finance 
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18 Follow-up of Unpaid Debts 
There are a number of reports within the system which can be used to assist with the follow up of 
unpaid debts. 

18.1 Identifying Outstanding Billing Items 

A report can be produced to list outstanding payments for items such as excursions and camps. 

18.1.1 Transaction Summary Report 

Activity: Print the Transaction Summary Report  
 
Print a report which lists all students who have not paid in full for the Camp. 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Click on Transaction Summary 

 Select the Billing Items radio button 

 Click New Query  

 Use the find tool to select All the Year 6 students (a form group can be selected if required) 

 Place a tick in the Student Totals Only box 

 Delete the default dates 

 Click on the Billing Options tab 

 Type an asterisk (*) in the Billing Item Batch field  

  Press <tab> 

 Select the Year 6 Camp and OK 

 Place a tick in the Billing Item Balance box 

 Click on the equals sign (=) and select the > operator from the list 
 

 
 Click Print 

 View the printed report detailed on the next page 
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 To see the individual billing items for each student uncheck the Student Totals Only 
checkbox 

 Click Print 
 

 A portion of the report is shown below 
 

 
 
  

 Close the reports window 
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18.1.2 Summary Aged Debt Lists 

This report is another useful way of identifying outstanding debtors. This report will display a list of 
Students or Customers (there is a separate report for each) who have an outstanding balance 
greater than zero. The amounts owing are classified into current, 30, 60 and 90+ day categories.   
 

Activity: Print the Summary Aged Debt List 
 
Print a Summary Aged Debt List for Students. 

RM Billing > Reports 

 Open the Financial Reports folder 

 Click on Summary Aged Debt List – Students 

 Click New Query  

 Use the find tool to select all students on the current roll 

 Click Print 

 View and close the report (example below) 
 

 
 

 

  
 

 Close the reports window 
 

Note: A Summary Aged Debt List for Customers can also be produced from the same 
section using the Customer report. 
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18.1.3 Printing Outstanding Items from the Billing Items batch 

Outstanding billing items can also be identified by looking at the billing items batch. 
 

Activity: Print Outstanding Billing Items from the Batch 
 
Print a list of outstanding billing items in the Year 4 Perth Zoo Excursion batch. 

RM Billing > Billing Items 

 Double-click on the Year 4 Perth Zoo Excursion batch 

 Click on the Batch Billing Items tab 

 Click Show Outstanding Amounts   

 Click on the Balance column heading twice so that the unpaid amounts are listed at the top 

 Click on the Student/Customer heading to order alphabetically 

 Highlight all billing items which have a balance > 0 
 

  
 

 Click Print Selected   

 View and close the report 

 Close the Billing Items window 
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Note: This report will always list the individual billing items whereas the previous report 
(Transaction Summary report) allows the overall totals per student to be displayed. 
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18.1.4 Using the Filter Function to identify outstanding debt 

Outstanding billing items can also be identified by using the Filter Function in a Billing Items Batch 
 

Activity:  Use the Filter Function to identify outstanding debt 
 
Print a list of outstanding billing items for the Year 6 Camp batch. 

RM Billing > Billing Items 

 

 Double click on the Camp Batch 

 Click on the Batch Billing Items tab 

 Click Show Outstanding Amounts   

 Click on the  Filter icon  (Filter the Billing Items agains a search criteria) 

 Place a tick the box for Balance 

 Change the equal sign to a Greater Than sign > 0.00 
 

 
 

 Click OK 
 
All the items with a Balance > $0 will be highlighted 
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 Click  and Ok to the screen 
 

 

 
 

 View and close the report 

 Close the Billing Items window 
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18.2 Notes 

It may be necessary at times to record certain information relating to students or parents regarding 
payment of accounts.  Attached to each student record is a ‘Notes’ tab that can be used for this 
purpose. Student Notes can also be viewed and printed from the Student List window.  An option is 
available to select a date range if searching for notes outside of the current date or to enquire as to 
when the notes were originally recorded. 
 

Activity: Enter Notes for Students 
 
Record the following notes for each student listed below. 
 

Name Subject Details 

Krystal Fava Charges and 
Contributions 

Ms Fava rang to say she will pay after she receives her 
tax refund. 

Cass Taylor Charges Ms Taylor rang to say that she will pay for the camp by 
the end of next week.  

Jenna Dudney Contributions Ms Dudney rang to say that she will not be paying for 
the remainder of Jenna’s costs as they are voluntary 
contributions. 

 

RM Billing > Students 

 Double-click on Krystal Fava 

 Click on the Notes tab 

 Click Add a note   

 Press <Tab> to accept today’s date 

 Type Charges and Contributions as the subject 

 Enter the details from the above table in the lower window 

 Click OK to save 

 Highlight the note 

 Click Edit   

 Add to the details ‘Tax refund expected late this term’ 

 Click OK 

 Click Return to View  

 Continue adding notes for the students in the table above 
 
To view an individual’s notes click on the Printer when in the Notes window. 
 

 In Krystal Fava’s window click Print   

 View and close the printed notes list 

 Click Return to View  
 

Note: It is good practice to enter your initials to the text when adding a note in RM Billing.  If 

a note is entered in error select the note and click Delete Note  . 
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18.2.1  Viewing Notes from the Student Screen 

Activity: Viewing Notes from the Student Screen 

RM Billing > Students 

 Click on the Notes Header twice to bring all students with notes to the top of the list 
 

 
 

 Highlight all the students who have a tick in the Notes column 
 

 Click For Selected and Print Notes 
 

 
 

 
 

 Enter a date range for the current month 

 Click OK 

 Repeat without entering a date range 

 Click OK and all notes are displayed 
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 View the Notes Report then close 
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19 Correcting Errors/Making Adjustments 
At times it may be necessary to correct an error made when entering a billing item or a receipt. 
Alternatively it may be necessary to make some type of an adjustment to a billing item or a receipt 
due to a change in circumstances. 
 
The table below outlines the different adjustment options which are available for billing items and 
receipts.  
 

Billing Items Receipts 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the billing item.  
 

 Used to correct an error 
(billing item should not have 
been created) 

 Used when a student should 
no longer be charged for an 
item (e.g. billed for Camp but 
now not going) 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the receipt. 
 

 Used to correct an error 

 Used for cheques that are not 
cleared 

 Used for EFTPOS payments 
that have failed 

 
(Note that billing item balances will 
be reinstated.) 
 

Adjustment This will create an adjustment 
transaction for the amount 
entered. This reduces the 
amount of the billing item by the 
adjusted dollar amount.  
 
Note: An alternative method 
could be to reverse the item and 
then add a new billing item 
which can be edited for a lower 
amount.   
 

Refund Used to refund amounts that have 
already been paid. 
 

 Used when money needs to be 
returned (refunded) to the 
parent. 

 
 
The associated billing items will be 
reversed automatically so that the 
debt is not reinstated. 

Write-Off This will create an opposite 
write-off transaction to negate 
the amount still owing on the 
billing item thereby ‘cancelling 
out’ the billing item. 
 

 Used at the end of the year 
to write-off debts that will not 
be recovered (in accordance 
with the Department’s write-
off policy) 

Note: The write-off procedure will be covered later in the training course. 
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19.1 Transaction References and Reasons (Discussion Only) 

19.1.1   Reasons 

If a transaction has been modified in some way (i.e. discounted, reversed, adjusted, written off or 
cancelled) then the reason field will begin with standard system-generated text (as shown below) 
followed by the reason entered by the operator. 
 
Types (for Billing Items). Valid Types for Billing Items are DR (Debit), RV (Reversal), AD 
(Adjustment) 
 
For Billing Items and their related transactions, reasons will begin with the following standard text. 
 

 
 
Type (for Receipts).  The transaction/payment type.  Valid types for receipt related transactions 
are – All Valid Payment Types RF (Refund) and RV (reversal). 
 
For Receipts and their related transactions, reasons will begin with the following standard text. 
 

 
 

19.1.2  Reference Number 

When a billing item is entered into RM Billing, a reference number is automatically applied to the 
billing item.  In the table below, the 3 reference item numbers apply to the tied camp billing items. 
 

   
 
When a billing item is reversed, it is reflected in two lines. 
 

  
 
The line for the Camp Accommodation reversal is identified by an R: (Reversal), followed by a 
corresponding reference number 513, showing that a reversal has taken place. 
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The lines displaying V: (Original), indicates that this is the original transaction and reference 
number.  This cross reference is particularly useful if there are multiple reversals, as it enables the 
user to match the original billing item to the reversed billing item using the transaction reference 
number. 
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19.2 Billing Item Reversals 

A billing item can be reversed if it has been entered in error, or if the student should no longer be 
charged for the item. Billing items may be reversed for an individual student or for a group of 
students. 

19.2.1  Reversals via Student Record 

Activity: Reverse Billing Items for a student  
 
Graeme Delamare has been billed for the camp for two days. We have now received notification 
that he is unable to attend because he has broken his arm.  As he should no longer be charged 
for the camp, his camp-related billing items will need to be reversed. 

RM Billing > Students 

 Double-click on Graeme Delamare 

 Click on the Billing Items tab 

 Highlight the first Camp billing item 
 

  
 

 Click Reversal   
 

 
 

 Click Yes 

 Enter a reason (e.g. ‘Not attending due to a broken arm’) 
 

  
 

 Highlight the reason and <Ctrl> C to copy the reason for later use 

 Click OK 
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A reversal transaction is created and both transactions now have a status and a reason. 
 

 Repeat the above process to reverse the second camp billing item for Graeme Delamare 
using <Ctrl> V to paste the reason 

 

  
 

 Click OK 
 

 
 
 
The Student Details Screen can be filtered to show only transactions for which there is an 
outstanding balance. This is useful to hide reversed items and their reversal transactions. 
 

 Click on   
 

 
Only Billing Items with an outstanding balance are now visible. 
 

 Return to Students   
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19.2.2 Printing an Updated Statement for the Student 

 

Activity: Print Updated Statement 
 
Print an updated statement for Graeme Delamare. 

RM Billing > Students 

 Highlight Graeme Delamare 

 For Selected > Print Statement 

 Click OK 

 View and close the new statement 
 

 

19.2.3 Printing an Unpaid Billing Items Reminder 

Schools may choose to send a reminder of Unpaid Billing items. Unlike a Statement which may 
include all transactions, the Reminder of Unpaid Billing Items report will produce a list of only 
Billing Item Transactions that have an Outstanding Balance. 
 

Activity: Print Reminder of Unpaid Billing Items 
Reports > Financial Reports > Reminder Unpaid Billing Items-Students 

 

  
 

 Click on New Query  

 Search for Graeme Delamare 

 Highlight Graeme and Click Select and Yes 

 Click  Print and OK 
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 View and Close 
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Activity: Review of Reversing a Billing Item 
 

 Kim Varricchio has not received permission from her parents to attend the zoo excursion and 
will not be attending. Reverse the Zoo Excursion billing items for this student. 

 
 

 Steven Smith has been banned from attending any incursions due to inappropriate 
behaviour.  It has been agreed with his parents that the billing item for the incursions will be 
reversed.   Reverse the incursions billing item for Steven. 

 

Note:  Don’t forget to start with the Month, followed by the Year 
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19.3  Billing Item Adjustments 

An adjustment can be used to reduce a billing item amount.   
 

Activity:  Adjustment of a Billing Item 
 
We have received notification that Tanya Born will be providing her own transport to the camp 
(one way only). The school has agreed to charge only half the transport cost for the camp.  

RM Billing > Students 

 Double-click Tanya Born 

 Select the Billing Items tab 

 Highlight the Camp Transport billing item 
 

  
 

 Click   
 

 
 

 Click Yes 

 Enter half the amount (20) into the ‘Adjust down by’ field 

 Enter a reason e.g. Month and Year ‘Providing her own transport to camp one way’  
 

  
 

 Click OK 

 View the adjustment in the billing items list 

 Click on  
 

 Close the student window 
 
Note:  An alternative way would be to apply a 50% discount to the Camp Transport billing item 
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20 Receipt Reversals 
 
 
A receipt can be reversed for a number of reasons. If the original batch the receipt was processed 
into has been closed, then an alternative batch must be created to either hold the receipt or pass 
the receipt through to another record.  If a receipt is to be refunded and the original batch has been 
closed, then a Refunds batch must be created to hold the reversed receipt. 
 

The Corrections Batch 

A Corrections batch would be created if the original batch the receipt was processed into has been 
closed and a receipt reversal is to be performed.  This could be because of user error resulting in a 
receipt having to be reversed or perhaps a cheque has been dishonoured by the bank, or a receipt 
has been applied against a wrong student record and therefore must be reversed and applied to 
the correct student. 
 

The Refunds Batch 

A Refunds batch would be created if money which has been paid, needs to be returned (refunded) 
to a parent/guardian.  Refund batches must be identified according to the type of refund  eg: EFT, 
System Generated Cheques or Manual written cheques.  If processing EFT refunds, the batch 
would be named Refunds – EFT dd/mm/yy etc. 
 
Unlike a General Banking batch or an EFT batch which may stay open until the banking is ready to 
be finalised, both the Corrections and Refunds batches are closed as soon as the Correction or 
Refunds have been completed. 
 

Non Exporting Schools 

Schools which are not exporting to RM Finance may write manual cheques or produce system 
generated cheques which can be created when the expenditure transaction is entered into RM 
Finance. 
 

Exporting Schools 

Schools which are exporting to RM Finance have the option of refunding through a Manual 
Cheque, a System Generated Cheque or through EFT.  This functionality is only available for 
Students at this time and not for Customer refunds.  Customer refunds must be made through a 
manual written cheque. 
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Activity: Create a Corrections Batch 
 
Create a Corrections batch using today’s date. (If processing Income receipts, a new General 
Banking Batch would also need to be created) 
 

 Corrections dd.mm.yy 

RM Billing > Receipts 

 Add Item  
 

 
 

 Click OK 

 Close the Receipts window 
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Activity:  Create Refund Batches 
 
Nora Chum’s mother has contacted the school to advise that Nora is ill and cannot attend the 
camp.  She has already paid in full and has asked for a full refund to which the school has 
agreed.  We will refund her using a system generated cheque. 
 
We have also been informed by West Coast Theatre that the hall is unsuitable and they have 
requested a refund. Also, Mrs Farmer has called to say that Kristof is ill and can’t attend the zoo 
excursion and would like the money refunded back into her bank account. 
 
As the original General Banking and EFTPOS batches are closed, refund batches must be 
created. 
 
Create 3 Refund batches for the following 
 

o Manual Cheque (WCT) dd/mm/yy 
o System Cheque (Nora Chum) dd/mm/yy 
o EFT (Kristof Farmer) dd/mm/yy 

 
RM Billing > Receipts 
 

 Click Add Item   
 

 
 

 Click OK 
 

 Click Add Item   
 

 
 

 Click OK 
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 Click Add Item   
 

 
 
 

 Click OK 
 

 We will record the numbers on the Finance Batch Register a little later in training 

 Close the Receipts window 
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Activity: Reverse and Re-Enter a Receipt 
 
It has been discovered that a $20.00 payment for Jackie Albert for the Zoo excursion, has been 
accidently applied to another student, Julie Edwards.  The receipt will now need to be reversed 
and then applied against the correct student. The reversal transaction must be placed into the 
Corrections batch.  
 

RM Billing > Students 

 Double-click Julie Edwards 

 Select the Receipts tab 

 Highlight the $20 receipt  

 Click   
 

 
 

 Click Yes 

 Enter a reason for the reversal (Error – applied against the wrong student) 
 

  
 

 Click OK 

 Select the Corrections batch 
 

  
 

 Click OK 
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Re-entering a Receipt 

 Right click in the Surname Field, type Albert and <enter>  

 Click   

 Tab in the Batch No field and select the Corrections Batch and OK 
 

  
 

 Tab to the Payment Type and select Cash and OK 

 Tab to the Amount and enter 20.00 

 Tab to the Comment and enter Year 4 Perth Zoo Excursion <tab> 
 
The payment will automatically apply to the first billing unpaid item.  As Ms Albert is paying for 
the excursion, delete the amounts from the applied column for voluntary contributions and add 
the charges next to the Zoo excursion. 
 

 
 

 Click OK 
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 Highlight the Receipt and view the details of the excursion items below 
 

  
 

 Click on   

 Click OK to print the Receipts 
 

 
 

 View the receipt 

 Close the  receipt 
 
Leave the window open 
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Activity:  Reverse a Receipt 
 
We have received notification from the bank that a cheque has not been accepted from Ms 
Ellard (for Kate Ellard) for the camp charges. The $250 receipt will need to be reversed and the 
reversal transaction must be placed into the Corrections batch. 

RM Billing > Students 

 Right click on Albert 

 Type in  Ellard and <Enter> 

 Select the Receipts tab 

 Highlight the $250 receipt 
 

 
 

 Click   
 

 
 

 Click Yes 

 Enter a reason for the reversal (e.g. Cheque not accepted by bank) 
 

  
 

 Click OK 

 Select the Corrections batch 
 

  
 

 Click OK 
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 View the reversal transaction 
 

  
 

 

IMPORTANT 

Normally a reversal would be posted into the same open Receipts batch 
as the original receipt.  However, if the original batch has been closed, 
you will be asked to select an alternative batch. The Corrections batch 

should be selected 
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20.1 Refunds 

A refund can be applied when money which has been paid, needs to be returned (refunded) to a 
parent/guardian or customer.  If exporting to RM Finance, a manual written cheque, a system 
generated cheque or an EFT refund can be used.  
 
If not exporting to RM Finance, the user may elect to issue a manual written cheque or alternatively 
a system generated cheque can be created when the expenditure transaction is entered into RM 
Finance. 
 
Refunds can be issued to both Parents/Guardians and Customers, providing their details have 
been entered in RM Finance.  If they do not exist in the RM Finance datafile, they may be added 
as a Supplier when processing the refund in RM Billing. 
 

20.1.1 Student Refunds 

Activity: Perform a Student Refund 
 
Nora Chum’s mother has contacted the school to inform them that Nora is ill and cannot attend 
the camp. She has already paid in full and has asked for a full refund to which the school has 
agreed.  

RM Billing > Students  

 Double-click Nora Chum 

 Select the Receipts tab 

 Highlight the Year 6 Camp  receipt to be refunded 
 

 
 

 Click   
 

 
 

 Select System Generated Cheque and OK 

 Enter the Refund amount of 250 (Note: Full or partial refunds can be entered) 

 <Tab> Enter the first 3 letter of the surname – CHU <Tab> 
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Mrs Cheryl Chum has not been added as a supplier, so in order for the refund to be processed, 
her details must be added to the supplier list. 
 

  
 

 Click OK 

 Click Add Record  

 Enter the following information 
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 Click OK 
 

 
 

 Click OK 
 

 
 
Cheryl Chum has now been entered as a supplier and the refund process can continue 
 

 Click OK 
 

 Enter the Reason for the refund 
 

 
 

 Enter the Amount of the refund for each billing item in the ‘Adjust by’ column 
 

 Select the correct Refund Billing Code for Charges (press <tab> in the ‘Ref Code’ field for a 
list) 

 

  



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 195 of 277 

© 2019 Civica Pty Ltd 

 

 

  
 

 Click OK 
 

 Select the Refunds-System Cheque batch  
 
 

  
 
 

 Click OK 
 
View the refund in the Student window 
 

  



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 196 of 277 

© 2019 Civica Pty Ltd 

 

 
 
 

  
 

 Close the student window 
 

Note: Refunds of unallocated credit are processed using a System refund code of SUS 
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20.2  Customer Refund 

Exporting schools have the option of refunding through Manual and System Generated cheques or 
EFT.  This functionality is only available for students at this time and not for customer refunds.  
Customer refunds must be made through a manual written cheque. 

20.2.1 Customer Refunds 

Activity: Perform a Customer Refund 
 
West Coast Theatre has informed us they will not be using the hall. They have asked for a full 
refund of their money to which the school has agreed.  Refund this amount to the customer. The 
manual cheque number is 123568. 

RM Billing > Customers  

 Double-click on West Coast Theatre  

 Select the Receipts tab 

 Highlight the receipt for 550 

 Click   

 Enter the refund Amount of 550 

 Enter the Reason for the refund 

 Enter the Amount of the refund in the ‘Adjust by’ column 

 Select the correct Refund Billing Code for Facilities Hire (press <tab> in the ‘Ref Code’ field 
for a list) 

 Enter the manual cheque number 123568 in the ‘Cheque Number’ field 
 

  
 

 Click OK 

Note:  The Customer Refund screen does not have the facility to enter a name in the 
‘Refunded To’ section.  The refund will automatically be recorded against the customer 
name which cannot change (whereas the fees biller for a student can.) 
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 Select the Refunds-Manual Cheque (WCT) 
 

  
 

 Click OK 
 

  
 

 Close the customer window 
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Activity:  Refund Via EFT 
 
Kristof Farmer’s father has called the school to say Kristof has chickenpox and will be unable to 
attend the zoo excursion.  He has asked if the money could be refunded via EFT into his bank 
account, to which the school has agreed.  
 
RM Billing > Students 
 

 Double click on Kristof Farmer 

 Click on the Receipt tab 

 Highlight the receipt for the Perth Zoo Excursion 

 Click  
 

 
 

 Select EFT and OK 

 Enter the refund amount of 20 

 <Tab> <Tab> to bring up a list of suppliers 
 
Mr Farmer is not in the list of suppliers, so will need to be added in order to process the refund. 
 

 
 

 Click Add Record  
 

 Enter the following information 
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 Click OK 
 

 
 

 Click OK 
 

 
 

 Click OK 
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 Enter the Reason for the refund <Tab> 

 Enter the EFT Reference (this is the name or initials of your school) <Tab> 

 Enter the Amount of the refund in the ‘Adjust by’ column <Tab> 

 Select the correct Refund Billing Code 
 

  
 

 Click OK 

 Select the Refunds-EFT batch 
 

  
 

 Click OK 
 

  
 

 View and Close 
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20.2.2 Transaction Summary Report 

The Transaction Summary Report can be used to view the details of Billing Items and Receipts 
that have been adjusted or reversed. 
 

Activity: Print the Transaction Summary Report  
 
Print a Transaction Summary Report for all Billing Items that have been reversed or adjusted 
along with their original transactions. This is a mandatory report and is required to be printed at 
the end of each month and signed by the Principal as part of end of month procedures. 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Select Transaction Summary 

 Select Both for Billing Items and Receipts 
 

 
 

 Delete the From and To Dates 

 In the Corrections drop down list select Adjustments/Reversals/Ref with Original Tx 
 

 
 

 Click Print 
 

Note: At school, the dates used for this report with be the month that you wish to report 
on. 
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 View and close the report and the reports window 
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21 Exporting to RM Finance 
 
The Correction and Refund batches must be exported as required.  All correction and Refund 
batches must be exported to RM Finance as part of the end of month procedures and before 
reconciling in RM Finance.  Once a batch has been exported, it is automatically closed so a new 
Corrections or Refunds batch would then need to be created in RM Billing. 

Important:  Ensure RM Finance is closed before exporting any batches   

21.1 Automatic Export to RM Finance 

The first steps as carried out for manual input need to be carried out for the automatic export.  The 
General Banking and Corrections batches must be printed separately, however the Refunds 
batches can be selected together for printing the Daily Banking and Receipts Summary.  They can 
also be printed as separate batches if required. 
 

Activity: Preparing for Automatic Export 
 
Print the Daily Banking for the Corrections batch 
 
Step 1 – Print the Daily Banking Summary 

RM Billing > Receipts 

 Highlight the Corrections batch 

 Click For Selected > Print Daily Banking 
 

  
 

 Print a paper copy of the report and file it 
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 Fill in the Finance Batch Register using the Daily Banking Summary 
 

 
 

Note: Reversals should be entered into the Adjustments/Reversals section in the Income 
(I/C) column. (Reversals are income corrections transactions).  Refunds should be entered 
into the Expend Payments (ESP) column. (Refunds are expenditure transactions). 

RM Billing > Receipts 

 Highlight the Corrections batch 

 Click For Selected > Print Receipts Summary 

 Click Yes to print the detailed summary 

 Print and file the report 
 
Print to view the Totals Only Report 
 

 Highlight the Corrections batch 

 Click For Selected > Print Receipts Summary 

 Click No to print the Totals Only Report 
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 View and close the report 
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Print the Daily Banking for the Refund Batches 
 
Step 3-Print the Daily Banking and Receipts Summary for the 3 Refunds batches 
 
The Daily Banking and Receipts Summary for the 3 Refund batches may be printed together or 
they may be printed separately, however when filling out the batch register, they must be 
entered and identified as separate batches. 
 
RM Billing > Receipts 
 

 Highlight the three Refunds Batches 
 

  
 

 Click For Selected > Print Daily Banking 

 Print a paper copy of the report and file it 
 

 
 

 Highlight the 3 Refund batches 

 Click For Selected > Print Receipts Summary 

 Click Yes to print the detailed summary 

 Print and file the report 

 Close the receipts batch window 
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 Fill in the Batch Register using the Daily Banking Report and ensure all batches are 
separated and identified as shown below on the batch register  

 

 
 
 

  



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 209 of 277 

© 2019 Civica Pty Ltd 

 

 

Activity:  Export The Batches 
 
RM Billing > Utilities 

Note:  Ensure RM Finance is closed before proceeding with the Export 

 Double click Export to RM Finance 
 

 
 

 Click Yes 

 Highlight all the batches in the Export window 
 

  
 

 Click OK 

 Check the setting on the Print Setup screen and click OK.  Do not cancel, otherwise 
transactions will not be exported 

 

Note:  The Export Summary Report will be sent straight to the printer.  There is no 
provision to send it to the screen until after it has been sent to the printer. The report 
must be signed by the Principal and filed with the monthly reports. 
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 Click Ok 

 Close the Utilities window 
 

Note:  When exporting to RM Finance, reversals are exported as Income Correction 
transactions.  Refunds are exported as expenditure transactions. 

A copy of the report is displayed below. 
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Note:  The Receipts Batch Export Summary report detailing the exported batches, must 
be signed and dated by the Principal and filed with the monthly reports. 
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21.1.1 Check and Update the Transactions in RM Finance 

It is now necessary to update the transactions that have been automatically exported from RM 
Billing to RM Finance. 
 

Activity: Update the Automatically Exported Transactions in 
RM Finance 
 
Step 1 – Check the Batched Transactions Report 
 
Open RM Finance 
 

 Log in as Manager Corporate Services and Password Keys 

Transactions 

 Select  

 Select the Batched Transactions Report 

 Select Income only 

 Select the Cheque Account only 
 

 
 

 Click Print 
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 This report should be checked against the receipts summary 
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Step 2 – Update the Income Correction Batch in RM Finance 

Transactions > View/Post Batch 

 

 Select Income 

 Enter Batch Ref B00004 
 

 
 

 Click Display  

 Click Select All  
 

  
 
 

 Click  

 Click Yes 
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Step 3 –Check the Batched Transaction Report for all Expenditure Batches 
 

 Select  

 Select the Batched Transactions Report 

 Select Expenditure only 

 Select the Cheque Account only 
 

 
 

 Click Print 
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 This report should be checked against the receipts summary 
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Step 4 – Update the Expenditure Batch for WCT in RM Finance 

Transactions > View/Post Batch 

 Select Expenditure and Credit Notes 

 Enter Batch Ref B00005 
 

 
 
 

 Click Display  
 

  
 

 Click Select All  

 Click  

 Click Yes 
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Step 5 –Update the Batch for Nora Chum 
 

Transactions > View/Post Batch 

 Select Expenditure and Credit Notes 

 Enter Batch Ref B00006 
 

 
 
 

 Click Display  
 

  
 

 Click Select All  

 Click  

 Click Yes 
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Step 6 – Update the Batch for Kirstof Farmer 
 
Kristof Farmer was refunded through EFT.  If your school has elected to use EFT/BPAY 
processing, the updating of an EFT batch is a two part process.  The Principal (or any other 
delegated cheque signatory) must log in to RM Finance and Certify the batch and then log out.  
The Registrar must then log in to RM Finance and Update the batch.  As we are not set up with 
the necessary access user rights, we will be unable to update this batch in training.  However, 
the same steps are carried out until the Update window displays. 
 
An EFT batch is updated by the EFT/BPAY Payment Summary option 
 

 Click View/Post Batch 

 Click EFT/BPAY Payment Summary 
 

 
 

 Enter the Batch Reference RMB000001EFT 
 

 
 

 Click Display  
 

  
 
Note there is no Update option and Certification must be performed by the Principal before the 
batch can be updated by the registrar. 
 

 Close the window 
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A System Cheque was selected as the preferred Refund option for Nora Chum.  This can now 
be printed from the Print Payments window. 
 
Transactions > Payments 
 

 Click Print Payments 

 Click the red Tick to highlight the payments 
 

  
 

 Click  
 

 
 

 Click Ok to the Cheque Number 
 

 
 

 Click Yes (the number would be entered on the Batch Register against System-cheque) 
 

 Close RM Finance 
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Manual input to RM Finance (For Reference Only) 

If the above Corrections batch were to be input manually into RM Finance, the details would need 
to be obtained from the Receipts Summary (Totals Only) report and entered as shown below. 
 
Income Correction transactions (Reversals) 

Inc 
Source 

Total Reference Batch Ref Detail Budget Analysis Tax Code 

INC001 140 B00006 B00004 School 
Camps 

C1102 C1100 0 

INC001 110 B00006 B00004 School 
Camps 

C1102 C1100 1 

 
Expenditure transactions (Refunds) 

Supplier Total Reference Batch Ref Detail Budget Analysis Tax Code 

Supplier 
Name 

140 123567 B00006 Refund 
Charges 

D4626 D4600 0 

Supplier 
Name 

110 123567 B00006 Refund 
Charges 

D4626 D4600 1 

Supplier  
Name 

550 123568 B00005 Refund 
Facility Hire 

D4808 D4800 1 

Supplier 
Name 

20 123567 B00007 Refund 
Charges 

D4626 D4600 0 
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22 Unallocated Credit 
If money has been receipted against a billing item and the billing item is reversed or adjusted, the 
money assigned to these items will become unallocated credit.   
 
If money is receipted before any billing items have been created then this money will be 
unallocated credit. Unallocated credit can either be refunded or can be used to pay for other billing 
items for the student in accordance with the parent’s instructions.   

22.1 Unallocated Credit via Student Record  

Activity: Reversal of Paid Billing Items 
 
Mason Richards is unable to attend the camp, but his parents have paid for it in advance. Judge 
Percival has called to say that the camp money can be used to pay for any other amounts which 
are outstanding for Mason and the rest held in credit.  Reverse the billing items for the camp. 

RM Billing > Students 

 Double click Mason Richards 

 Select the Billing Items tab 

 Highlight the first item for the camp 

 Click   

 Click Yes to the reversal message 

 Enter a reason for the reversal e.g. Date and Month, Not attending camp (Ctrl + C) 

 Click OK 

 Continue reversing the other two camp billing items 

 View the unallocated credit at the bottom of the student window 
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 View Mason Richards’ record with only the Outstanding Billing Items displayed 
 

 Click on  
 

  
 

 Close the student window as we will allocate the credit later 
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22.2 Auto Allocate Unallocated Credit 

It is possible to automatically allocate unallocated credit to billing items.  Credit will be allocated 
according to existing rules for parent receipts and subsidy amounts.   

22.2.1 Reversals via the Billing Items Batch  

Activity: Bulk Reversal of Billing Items 
 
Due to unforeseen circumstances, the planned Year 1 Science incursion has been cancelled.  It 
has now been decided to take the Year 1’s on an excursion to AQWA as part of their science 
study of ‘Life Beneath the Sea’.  The cost will remain the same, however the money paid against 
the incursion must be reversed and allocated against a new billing item and budget code. 
 
RM Billing > Billing Items 
 
The amounts paid for the Year 1 incursion must be reversed and allocated to a new excursion 
billing item. 
 

 Double click on the Year 1 & 2 Science Incursion batch 

 Click on the Batch Billing Item tab   
 

 Click   

 Highlight the Year 1 Incursions 
 

  
 

 Click on Reverse the selected billing items   
 

 
 

 Click Yes to message 
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 Add a reason – Incursion has been cancelled 
 

  
 

 Click OK 
 
This will result in $10 unallocated credit being applied to all Year 1 students in their Billing Items 
window 

 Click Return to View   
 
A new billing item must now be created for the AQWA excursion 
 

 Click Add  

 Enter the description Year 1 AQWA Excursion 

 Click OK to save 

 Click Add Debit   

 Enter the description 2019 Year 1 AQWA Excursion 

 Type 10 in the amount 

 Type 0 in the GST field or <tab> to select the relevant code for excursions (CHG02) 

 Click OK 
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This $10 unallocated credit can be viewed for all the Year 1 students in their Billing Items 
window 
 
RM Billing > Students  
 

 Find Kristel Marshall’s Record 

 View her Billing Items tab 
 

   
 

 View her Unallocated Credit 
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23 Locating All Unallocated Credit Amounts 
A report can be produced to list all students and/or customers who have unallocated credit. 
 

Activity: Produce an Unallocated Credit Listing Report 

RM Billing > Reports 

 Open the Financial Reports folder 

 Select the Unallocated Credit Listing 
 

 
 

 Sort by Total 

 Ensure Students is selected 

 Click Print 
 

Note: The Unallocated Credit Listing now allows users to sort by Current Balance, Total, 
Unpaid Billing Items, Form or Year. 
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Activity: Auto Allocate Unallocated Credit 
 
Before using the Auto Allocate function, students will need to have the new Billing Item applied 
to their records. 

RM Billing > Students 

 Sort by Year Group 

 Select the Year 1 students 
 

 
 

 Choose For Selected > Add to Billing Item Batch 

 Select the Year 1 AQWA Excursion batch 
 

  
 

 Click OK 
 
It is now possible to Auto Allocate the $10 unallocated credit to the new billing item 
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RM Billing > Billing Items 

 

 Double click on the Year 1 AQWA Excursion batch 

 Click the Batch Billing Items tab    
 

 Click  (this ensures that the balances owing on the billing items after 
adjustments if any are displayed) 

 

 Highlight all the students 
 

  
 

 Click Auto Allocate to apply credit to the selected billing items   
 

 
 

 Click Yes to allocate the unallocated credit to the new billing item 
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The following message will display 
 

 

Note:  This function produces a report to the default printer and there will not be a chance 
to select the report destination, so select the report location in advance. 

 
 

 It the report has printed correctly 

 Click OK 
  

A copy of the report is shown below 
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The report can be reprinted through RM Billing > Reports > Transactional Reports > Re-
Print Auto Allocate Transaction 
 

  
 
 

 Highlight the Auto Allocate Report and Reprint to the Screen 
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Activity: Allocate Unallocated Credit 
 
Judge Percival (Mason Richards’ guardian) has advised that some of the camp credit is to be 
used to pay for other outstanding items. We will now allocate the unallocated credit. 

RM Billing > Students 

 Double-click Mason Richards 

 Select the Billing Items tab 

 Click on  

 Highlight all the Billing Items 
 

 
 

 Click   

 Enter the amount to allocate 
 

 
 

 Click OK 

 View the Billing Items  
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 Click on  
 

  
 

 View there are no  Billing Items with Outstanding Balances 

 Close the student window 
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Check the Unallocated Credit Listing again  
 
 
Reports > Financial Reports > Unallocated Credit Listing 
 

 View Mason’s remaining unallocated credit 
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23.1 Exporting Re-allocations to RM Finance 

Movement of payments from one billing code to another where the billing codes are different and 
are posted to different Analysis and Budget codes, will result in a re-allocation transaction. These 
changes must be reflected in RM Finance.   The Export to RM Finance Utility will process these re-
allocations automatically in the original batch the transactions were processed in.  This batch is 
identified with an asterisk. 
 

Activity: Export Re-Allocations 

RM Billing > Utilities 

 Double-click Export to RM Finance 
 

 
 

 Click Yes 

 Highlight both the General Banking Batches 
 

  
 

 Click OK  
 

 
 

 Click OK 
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The Export Summary Report will be sent straight to the printer. There is no provision to send it to 
the screen. The report must be signed by the Principal and filed with the monthly reports.  A 
copy of the report is shown below. 
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Activity: Update the Automatically Export Transactions 
 
Open RM Finance 
 

 Log in as Manager Corporate Services and Password Keys 
 

  
 
Step 1 - Check the Batched Transaction Report 

Transactions 

 Select  

 Select the Batched Transactions Report 

 Select Income only 

 Select the Cheque Account only 
 

 
 Click Print 
 
A copy of the report is displayed below 

 



  

 
RM Billing Primary Training Notes.docx31-Dec-18  

Page 239 of 277 

© 2019 Civica Pty Ltd 
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Step 2 – Update the Income Batches in RM Finance 

Transactions > View/Post Batch 

 Select Income 

 Enter Batch Ref B00001 
 

 
 

 Click Display  

 Click Select All  
 

  
 

 Click  

 Click Yes 
 

 

 

Note:  If not exporting to RM Finance, then the Reallocation Transactions must be entered 
manually as Income Corrections, followed by the corresponding Income Transactions. 
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Repeat for Batch Ref B00003 
 

Transactions > View/Post Batch 

 Select Income 

 Enter Batch Ref B00003 
 

 
 

 Click Display  

 Click Select All  
 

  
 

 Click  

 Click Yes 
 

 Close RM Finance 
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24 Changes in Student Admin 

24.1 Moving a student to the Former Roll 

When a student is moved to the Former Roll their RM Billing information can still be accessed. 
 

Activity: Move a Student to the Former Roll 
 
Reuben Baker is leaving the school today so will need to be moved to the Former Roll.  Move 
him to the Former Roll and then locate his details in RM Billing. 

General > Student Details 

 Use the Search field to locate Reuben Baker    
 

 

 Click Move Student to Former Roll  
 

 
 

 Click Yes to the Warning Message 

 <Tab> to accept the default date 

 Select a destination and enter a reason for leaving 
 

  
 

 Click OK 
 
Reuben is now on the Former Roll 
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RM Billing > Students 

 Click Student Find   

 Select the Former Roll and find Reuben Baker 
 

 
 

 Double click Reuben Baker 

 Click on  to view his Billing Item balance 
 

 
 

 Click Return to View  

 Highlight Reuben Baker 

 Click For Selected > Print Statement > OK 

 View and close the statement 

Note: Billing information can still be accessed, statements created and receipts entered 
as necessary. 
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24.2 Student Name Changes 

Occasionally, student name changes occur.  When this change is made in General>Student 
Details, users will need to update the records in RM Billing.  This update can be run through the 
individual student screen or by running a utility to update the records of all students with a name 
change. 
 

Activity: Student Name Change 
 
Kate Ellard’s guardians have provided the relevant documentation advising that Kate will now be 
known as Kate Donovan. 
 
 General > Student Details 
 

 Load the Records for Kate Ellard and select Kate 
 

 
 

 Click on edit student  

 Enter Donovan in the Surname and Legal Surname  
 

  
 

 Click OK 
 
A name change icon now appears on the Student’s status bar 
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RM Billing > Students 

 

 Find Kate Ellard and open her record 
 
Note that the name change is not showing in Students List 
 

  
 
The updated name appears under student details. The ‘Update Student name from Admin’ icon 
appears on the student record and when clicked will update the student’s record. 
 

 Click on the  icon to update Kate’s record 
 

 
 

 Note that the name details have updated 

 Return to View  

 Highlight Kate Donovan 

 For Selected > Print Statement > OK 

 View and close the statement 
 

 

24.3 RM Billing > Utilities > Update Student Details from Admin 

There is also the option to use the name update utility which will update the records for all 
students with name changes. 
 

 Click on Update Student Details from Admin, the following message will appear. 
 

 
 

 To update RM Billing with any student name changes from the Administration module click Yes  

 A report will be produced listing the names of students that have been updated 
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25 Write-offs 
It will be necessary to write off irrecoverable charges from students on the Current and Former 
Roll.  It is important that reports created using this process are kept on file for use at a later date.  
Write-offs can be performed whenever charges are deemed as irrecoverable from current and 
former roll students.   
 
Refer to Department of Education’s Write-Off Procedures for Irrecoverable Debts document for 
further information regarding all write-offs. 
 
At the beginning of a year schools should look back at their previous year’s billing data. Any 
amounts which are deemed as irrecoverable can be written off. Write-offs from previous years can 
also take place throughout the year however they should only be submitted to DoE once a year.  
Schools should maintain a write-off file throughout the year which contains: 
 

 a copy of all write-off applications (including provisionally approved applications), lists and 
supporting documents; 

 a copy of all approvals from Corporate Business Services to write-off for debts; and 

 all other relevant supporting documents. 
 

In accordance with Treasurer’s Instruction 107 Authorisations, the Director General has authorised 
school principals to provisionally write-off irrecoverable debts with a value of up to $5 000. These 
write-offs have to be periodically submitted to the Director General for the final approval.  For 
further information refer to the Department’s documentation. 
 
Unpaid voluntary amounts will need to be removed from current and former roll students.  These 
amounts can be cancelled.   They do not have to be reported to the Department of Education.  
 
Refer to the Department of Education policies for more information.   
 

IMPORTANT:  
Ensure a copy of all write-off applications, supporting documents, 

reports and approvals are filed.  
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A copy of the School Write-Off application form for $5000 or less, is displayed below. 
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25.1 Writing off Student Debt 

When writing off billing items for students, the user will access Write off-Cancel Student Related 
Debt via the Utilities menu. 
Writing off student debt may be carried out at any time during the year, if it is deemed that the debt 
is unrecoverable. 

25.1.1 Creating billing item batches for written-off or cancelled amounts  

Activity: Create a Student Write-off Batch 
 
As part of the end of month process and at the end of each year, it is necessary to review 
current and former roll students and write off irrecoverable charges and cancel uncollected 
voluntary contributions.  A billing item batch will need to be created in order for the write off 
amounts to be processed into. 

RM Billing > Billing Items 

Charges and Contributions have been deemed unrecoverable for some students.  Create a 
write-off batch to hold the written off amounts. 
 

 Click Add Item  

 Enter the description as Writeoff/Cancel outstanding debts <$5000 per student 

 Click OK 
 

  
 

 Click Return to View  
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Activity: Create a Customer Write-off Batch 

RM Billing > Billing Items 

West Coast Theatre has gone into receivership and charges have been deemed as 
unrecoverable.  Create a write-off batch to hold the written off amount. 
 

 Click Add Item  

 Enter the description as Writeoff outstanding debts <$5000 per customer 

 Click OK 
 

  
 
 

Note:  Customer debt cannot be cancelled.  It can only be written off. 
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25.1.2  Writing off Student Debt as part of end of month procedure 

Activity:  Write off Student Debt for Current Year 
 
Reuben Baker has left the school and it has been deemed that his charges are unrecoverable.  
Approval for the write off has been received from the Principal, so as part of the end of month 
procedure, his debt will be written off. 

RM Billing > Utilities 

 Double Click Write off-Cancel/Student Related Debt 
 

 
 

 Click Yes 

 Select 2019  
 

  
 

 Click the Student Find   
 

 Select the Former roll   

 Click Find     and highlight Reuben Baker 

 Click Select  

 Click OK 
 

 Click in the boxes for CHG, VOL, VAR and OOC  
 

 
 

 Click Print Selected  
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This report must be printed and signed by the Principal and filed in the write-off file. 

Clicking    will print a list of all students viewed in the Write off-Cancel Debt 
screen.  This report should not be used to record the Principal’s authorisation for write 

off. The user must select the Print Selected printer  

  
 
 
 
 
 

 
 
 

 Close the report 
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 For Selected > Write off/Cancel Student Related Debt 
 

 
 

 
 

 Click Yes 
 

  
 

 Click Yes 

 Press <Tab> in the Batch and select the Write-off/Cancel outstanding debts <$5,000 per 
Student batch and OK 

 

  
 

 Enter the reason for the write off as ‘Provisional Approval dd.mm.yy’ (Today’s date) 
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 Click OK 
 

 
 

 Click OK 

 The debt is removed from the Write-off screen 
 

 
 

 Close the Write off/Cancel Student Related Debt window 
 

Note: These batches are only created when required for write-off purposes.  Billing Item 
Batches can be duplicated from the Billing Items list by selecting the batch to be 
duplicated and choosing For Selected > Duplicate Batch. 
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25.1.3 Writing off Debt for Several Students 

When charges are deemed as unrecoverable for more than one student, they can be written off. 
 

Activity: Write-Off Debt in Bulk 
 
Charges and contributions have been deemed as unrecoverable for several Year 6 students.  
Approval for write-off has been received by the Principal.  Produce a write-off report for the 
Principal to sign.  Write off debt for these students. 

RM Billing > Utilities 

 Double click Write off/Cancel Student Related Debt 
 

 
 

 Click Yes 

 Select 2019 as the Year 
 

 
 

 Click Student Find   

 Select Year Group 6 

 Click Find  

 Highlight the first 3 students 
 

 
 

 Click Select and Yes 

 Click OK 

 Put a tick in front of CHG, VOL, VAR AND OOC 

 Highlight the students 
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 Click Print Selected  

Note: This report must be printed, signed by the Principal and filed in the write-off file. 

 Close the report 

 Highlight all students 

 For Selected > Write off/Cancel Student Related Debt 
 

 
 

 Click Yes 
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 Click Yes 

 Press <Tab> in the Batch field 

 Select the Writeoff/Cancel outstanding debts <$5000 per student batch and click OK 

 Enter the reason for the write off as ‘Provisional Approval dd.mm.yy’ (Today’s date) 
 

 
 

 Click OK 
 

 
 

 Click OK 

 The debt is removed from the Write-off screen 
 

 
 

 Close the Write-off/Cancel Student Related Debt window 
 

 

IMPORTANT:  

Use the write-off report from RM Billing and follow the write-off 
procedures to submit the School Debt Write-off Application Form ($5000 
or less) to Corporate Business Services for final write off approval from 
the Director General.  Voluntary amounts are cancelled, not written off, 

therefore must not be included in the application. 
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Activity: View Write-Off/Cancelled Billing Items for Students 

RM Billing>Students 

 Open the record for Ross Barbour 

 Select the Billing Items Tab 

 Click on the Reason header 

 View the written off and cancelled debt. 
 

  
 

 View the Record after clicking on  
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 Close out of Student Details 
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25.2 Writing off Customer Debt 

When writing off billing items for customers, the user will access Write off/Cancel Customer 
Related Debt via the Utilities menu, however Customer debt can only be written off, it cannot be 
cancelled. When charges are deemed as unrecoverable from customers they can be written off. 
 

Activity: Write-Off Customer Debt 
 
West Coast Theatre has gone into receivership and charges have been deemed as 
unrecoverable.  Approval for write-off has been received by the Principal.  Write off debt for this 
customer. 

RM Billing > Utilities 

 Double click Write off/Cancel Customer Debt 
 

 
 

 
 

 Click Yes 

 Select 2019 as the Year 
 

  
 

 Click Customer Find  

 Select West Coast Theatre 
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 Highlight the line for the 2019 Hall Hire Term 1 Weeks 6-10 for $495 

 

  
 

 Click OK 

 

  
 

 Click Yes 

 <Tab> in the Batch field  

 Select the Writeoff Outstanding Debts <$5000 per customer  
 

 
 

 Click OK 

 Enter the reason for the write off as ‘Provisional Approval dd.mm.yy’ (Today’s date) 
 

 
 

 Click OK 
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 Click OK 

 Close the Writeoff Customer Debt Window 
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25.2.1 Printing the Transaction Summary for Customer Write-offs 

A write-off report must be printed and signed by the Principal for all Customer write-offs.  This 
report must then be filed. 
 

Activity: Print the Write-Off Report for Customers 
 
Print the transactions summary report for West Coast Theatre for the Principal to sign and to be 
filed. 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Select the Transaction Summary 

 Select Billing Items 

 Click Customer Find   

 Select West Coast Theatre 
 

 
 

 Enter the relevant date range 

 Select the Other tab 

 Enter the Reason containing Writeoff (No spaces) 
 

 
 

 Click Print 
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 This report must be signed by the Principal and filed 
 

  
 

IMPORTANT:  

Use the write-off report from RM Billing and follow the write-off 
procedures to submit the School Debt Write Off Application Form 
($5000 or less) to Corporate Business Services for final write off 

approval from the Director General.   
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25.2.2 Closing the Write-off Batches 

The write-off batches must be closed and a new batch will need to be created for the next write-
off/cancellation. 
 

Activity: Close the Write-Off Batches 
 
As the write-offs have now been completed and the School Debt Write-off Application Form 
($5,000 or less), submitted it is now necessary to close off the write-off batches.  This can be 
done individually or if there is more than one batch to close, they can be done together. 
 

RM Billing > Billing Items 

 Highlight both Writeoff batches 
 

  
 

 Click For Selected > Close Batch 
 

 
 

 Click Yes 
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The two batches are now closed 
 

  
 

 Close the Billing Items window 
 

 

IMPORTANT:  

When writing off customer debt for more than $5000, approval must be 
received from the Director General.  Complete and submit the School 
Debt Application Form (over $5000) available on the Finance Web, for 

approval from the Director General.  Once approval has been received, 
complete the write-off procedure. 

 

IMPORTANT: 

 Use the write-off report from RM Billing and follow the write-off 
procedures to submit the School Debt Write-Off Application Form 
($5000 or less) to Corporate Business Services for final write off 

approval from the Director General.  
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26 Purging Transactions 
RM Billing now has a Utility that enables Users to purge transactions from Former Roll students 
where transactions have a zero balance and the student has a Leave Date of more than one year 
prior to the last Billing Year End date. 
 
The Utility is accessed from RM Billing > Utilities  
 

 
 

 
1. This process is required to be run in single user mode. 

 
2. Once the process has been instigated the user will be prompted to enter the message for the 

single user lock. 
 

 
 
3. The following message is then displayed. 
 

  
 
4. Selecting ‘Yes’ will display the Student Find Tool. 
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5. If the user clicks OK without selecting any students the following message is displayed 

 

 
 
6. When OK is clicked the message closes but the student find window remains open  
 
7. Once the user has selected students, the eligible students will be displayed in the following 

window. 
 

 
 
8. The user will highlight students and click the ‘Purge Selected Students’ button. 
9. The following message is then displayed. 
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10. When the user clicks ‘Yes’, a series of different progress messages are displayed (some 
examples appear below), so the user is aware of the different stages in the process. 

 

 
 

 
 
11. When the process has completed the following message is displayed. 
 

 
 
12. An archive report is saved to the specified location. 

 
13. Archived reports can be run from within Integris from the File > Print Saved Reports (from 

disk) menu option. 
 

 

 

Note: As we do not have any transactions against Former Roll students prior to the current 
Billing Year, we are unable to demonstrate this process during Training. 
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IMPORTANT  

Please note that the Billing Archive folder needs to be created with a 
space in between the words ‘Billing’ and ‘Archive’ as shown in the 

screen shot above. 

 The specification lists this folder name without a space. 
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27 End of Month Procedures and Reporting 
Whilst RM Billing does not have a month end roll over function, certain tasks need to be performed 
in RM Billing at the end of each month. This will ensure that RM Billing and RM Finance are co-
ordinated and also that any items which may need attention in RM Billing are handled in a timely 
fashion.  

27.1 Month End Checklist 

The following check list should be used for RM Billing at the end of each month. (Refer to the RM 
Finance Registrar’s End of Month Check List (For RM Billing Schools) provided by the Department 
of Education for further detail.) 
 

Task Necessary Steps 

Review students on the 
former roll 

 Process refunds or transfer transactions if required. 
 

 Process write-offs for unrecoverable debt according to 
department policy. 

Review students on the 
current roll 

 Process refunds if required. 
 

 Process write-offs for unrecoverable debt according to 
department policy. 

Check and clear 
unallocated credits in RM 
Billing 

 Print the Unallocated Credit Listing (Reports > Financial Reports 
> Unallocated Credit Listing for both Students and Customers). 

 

 Investigate each occurrence and allocate or refund credit 
amounts where applicable.   

Ensure all transactions 
are transferred to RM 
Finance 

 If not exporting to RM Finance, ensure all receipts batches in 
RM Billing have been balanced with the banking, reports printed 
and batches closed. Ensure all receipts batches in RM Billing for 
the current period have been posted into RM Finance. 

 

 Print any re-allocation transactions (Reports > Transactional 
Reports) and ensure they are posted into RM Finance.  

OR 

 If exporting to RM Finance, export the Corrections batch to 
RM Finance and any other open receipts batches (RM Billing > 
Utilities > Export to RM Finance). Where applicable 

 

 Follow the procedures listed in these notes regarding filling in 
the batch register and which reports to print. The Receipts Batch 
Export Summary is printed automatically on export.  

 

 Print the Receipt Batch Summary Report showing there are no 
batches to export 
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Review the Billing 
Suspense Account 
(N3199) in RM Finance.  
This holds the 
unallocated credit 
amounts. 

 If the balance is not zero, check the report and view the 
transactions to determine if correct. Make corrections if 
necessary. 

 

 The total in the Billing Suspense account should equal the 
amount of unallocated credit reported on the Unallocated Credit 
Listing in RM Billing – unless there are any unexported batches 
for the next month or unallocated Government Subsidies 

Check all batches are 
updated in RM Finance 

 RM Finance > Reports > Batched Transactions.  Check for 
Income and Expenditure to the relevant bank accounts.  If a 
report is produced investigate the reason why these batches are 
yet to be updated in RM Finance.  Update the batches. 

 

Check the balance of 
N3505 in RM Finance is 
zero 

 A balance in this account indicates a GST posting error in RM 
Finance. 

Perform the reconciliation 
of all bank accounts in 
RM Finance 

 Clear 0.00 transactions by reconciling them. 
 

 The RM Billing portion of the bank deposit should be reconciled 
with the Daily Banking Summary and the Batch Register. 

 

 The RM Billing Batch Number should be noted against the 
relevant deposit on the bank statement. 

 

Check for negatives on 
the BAS as a result of 
Adjustments 

 If any negatives exist seek help from your SFC(S). 

Print the following RM 
Billing Reports 
(mandatory) 

 Audit Report (Reports > Audit Reports > Audit Report.) Save 
this report as <Month yyyy> to disk (G:\RM Billing Audit Log 
<yyyy>). 

 

 Receipt Batch Export Summary- if exporting.  This report is 
only printed automatically on export.  It is to be signed by the 
Principal on each export.  If any batches remain unexported 
these should be noted on the report with a reason why they have 
not been exported. 

 

 Transaction Summary Report for the current month for 
correction items - Principal to sign (Reports > Transactional 
Reports > Transaction Summary). See screen shot below – date 
range should be for the month being reported) 
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 Transaction Summary Report for discounted items (no date 

range) - Principal to sign (Reports > Transactional Reports > 
Transactions Summary > Billing Options tab > tick Show 
discounted billing items only > Other tab > Enter Comment 
Containing Month and Year) 

 

 
 

 
 

Print the following RM 
Billing Reports (optional) 

 Summary Aged Debt List (Optional Report) when required, 
for debt management.  (Reports > Financial Reports > Summary 
Aged Debt List – Students and/or Customers) 

Note: Questions on month end procedures can be directed to your SFC(S).  
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28 Support 
Should you require support please email: FinancialServices.support@det.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 
Contact details below: 

28.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please supply your ID number, contact details and a brief description of the problem. 

28.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

29 Online Manuals and Training Notes 

29.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
www.civicaeducation.com.au. 
 
Select online manual login. 
Username: school 
Password: help 
 

29.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
  

mailto:FinancialServices.support@det.wa.edu.au
http://www.civicaeducation.com.au/
http://www.det.wa.edu.au/intranet/stims
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30 Finance Web 

30.1 Department of Education – SIS Finance 

 
http://det.wa.edu.au/finance/detcms/portal/ 
 
Log on to the DoE Portal to access the latest factsheets. 
 
RM Billing - Quick Reference Guide and FAQ 
RM Billing - Receipts Batches Procedures in RM Billing 
RM Billing - Using RM Billing _Alternative Method for Timetabled schools Yrs 7 -10 
 
 

http://det.wa.edu.au/finance/detcms/portal/


 

DEPARTMENT OF EDUCATION 

BATCH REGISTER 

     For the month of                                                                            Period      

     BANK RELATED TRANSACTIONS       

Batch No 
Date/D

ate 
Export 

Reference No   

Bank 
A/C 

1, 2, 3 

Income 
Receipts 

(INC) 

Expend 
Payments 

(ESP) 

Credit 
Notes 

Adjustments/Reversals ** 

Internal 
Charge** 

Accruals 
(Manual 

Only) 

BA/Vire 
Totals 

Proc 
By From To 

Type of  
Batch* 
[C] Cheque 
[E] EFT 
[B] BPay 

 

Income 
(I/C) 

Expend  
(ESC) 

          
  
         

               

               

                   

          
  
         

          
  
         

          
  
         

          
  
         

               

          
  
         

               

                  
  
  

  
          

                  
  
  

  
          

                

                

                

 

*Reversals and internal charges are not batched but must be recorded.  Billing batches are prefaced with a ‘B’.  Accruals are entered if manually 
processed. 


